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Preface

Thank you for purchasing TOSHIBA Multifunctional Digital Systems or Multifunctional Digital Color Systems. This manual 
explains the instructions for installing client software. Read this manual before using your Multifunctional Digital Systems 
or Multifunctional Digital Color Systems. Keep this manual within easy reach, and use it to configure an environment that 
makes best use of the e-STUDIO’s functions.

How to read this manual

Symbols in this manual
In this manual, some important items are described with the symbols shown below. Be sure to read these items before 
using this equipment.

Other than the above, this manual also describes information that may be useful for the operation of this equipment with 
the following signage:

Trademarks
The official name of Windows 2000 is Microsoft Windows 2000 Operating System.
The official name of Windows XP is Microsoft Windows XP Operating System.
The official name of Windows Vista is Microsoft Windows Vista Operating System.
The official name of Windows 7 is Microsoft Windows 7 Operating System.
The official name of Windows Server 2003 is Microsoft Windows Server 2003 Operating System.
The official name of Windows Server 2008 is Microsoft Windows Server 2008 Operating System.
Microsoft, Windows, Windows NT, and the brand names and product names of other Microsoft products are 
trademarks of Microsoft Corporation in the US and other countries.
Apple, AppleTalk, Macintosh, Mac, Mac OS, Safari, and TrueType are trademarks of Apple Inc. in the US and other 
countries.
Adobe, Adobe Acrobat, Adobe Reader, Adobe Acrobat Reader, and PostScript are trademarks of Adobe Systems 
Incorporated.
Mozilla, Firefox and the Firefox logo are trademarks or registered trademarks of Mozilla Foundation in the U.S. and 
other countries.
IBM, AT and AIX are trademarks of International Business Machines Corporation.
NOVELL, NetWare, and NDS are trademarks of Novell, Inc.
TopAccess is a trademark of Toshiba Tec Corporation.
Other company names and product names in this manual are the trademarks of their respective companies.

Indicates a potentially hazardous situation which, if not avoided, could result in death, serious 
injury, or serious damage, or fire in the equipment or surrounding objects.

Indicates a potentially hazardous situation which, if not avoided, may result in minor or moderate 
injury, partial damage to the equipment or surrounding objects, or loss of data.

Indicates information to which you should pay attention when operating the equipment.

Describes handy information that is useful to know when operating the equipment.

Pages describing items related to what you are currently doing. See these pages as required.
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About the Client CD-ROM

For Windows
The contents of the Client Utilities CD-ROM:

Client software installer
[Client Utilities CD-ROM]:\e-STUDIO\Setup.exe
This is the setup program to install the printer drivers on your computer.

PCL6 printer drivers
[Client Utilities CD-ROM]:\Client\Drivers\PCL6\W2K_XP_VISTA\<language>\
This includes the setup files to install the PCL6 printer driver on the Windows 2000/Windows XP/Windows Vista/
Windows 7/Windows Server 2003/Windows Server 2008 for each language version by Add Printer Wizard or Plug and 
Play.
[Client Utilities CD-ROM]:\Client\Drivers\PCL6\XP_VISTA_X64\<language>\
This includes the setup files to install the PCL6 printer driver on the Windows XP/Windows Vista/Windows 7/Windows 
Server 2003/Windows Server 2008 64-bit edition for each language version by Add Printer Wizard or Plug and Play.

PCL5c printer drivers
[Client Utilities CD-ROM]:\Client\Drivers\PCL5c\W2K_XP_VISTA\<language>\
This includes the setup files to install the PCL5c printer driver on the Windows 2000/Windows XP/Windows Vista/
Windows 7/Windows Server 2003/Windows Server 2008 for each language version by Add Printer Wizard or Plug and 
Play.
[Client Utilities CD-ROM]:\Client\Drivers\PCL5c\XP_VISTA_X64\<language>\
This includes the setup files to install the PCL5c printer driver on the Windows XP/Windows Vista/Windows 7/Windows 
Server 2003/Windows Server 2008 64-bit edition for each language version by Add Printer Wizard or Plug and Play.

PS3 printer drivers (PostScript)
[Client Utilities CD-ROM]:\Client\Drivers\PS\W2K_XP_VISTA\<language>\
This includes the setup files to install the PS3 printer driver on the Windows 2000/Windows XP/Windows Vista/
Windows 7/Windows Server 2003/Windows Server 2008 for each language version by Add Printer Wizard or Plug and 
Play.
[Client Utilities CD-ROM]:\Client\Drivers\PS\XP_VISTA_X64\<language>\
This includes the setup files to install the PS3 printer driver on the Windows XP/Windows Vista/Windows 7/Windows 
Server 2003/Windows Server 2008 64-bit edition for each language version by Add Printer Wizard or Plug and Play.

XPS printer drivers
[Client Utilities CD-ROM]:\Client\Drivers\XPS\W2K_XP_VISTA\<language>\
This includes the setup files to install the XPS printer driver on the Windows XP/Windows Vista/Windows 7/Windows 
Server 2003 for each language version by Add Printer Wizard or Plug and Play.
[Client Utilities CD-ROM]:\Client\Drivers\XPS\XP_VISTA_X64\<language>\
This includes the setup files to install the XPS printer driver on the Windows XP/Windows Vista/Windows 7/Windows 
Server 2003 64-bit edition for each language version by Add Printer Wizard or Plug and Play.

The XPS printer driver can be installed on Windows Vista/Windows 7 computers, or those of Windows XP SP2, 
Windows Server 2003 SP1 or later versions with XPS Essentials Pack installed.

N/W-Fax drivers
[Client Utilities CD-ROM]:\Client\Drivers\FAX\W2K_XP_VISTA\<language>\
This includes the setup files to install the N/W-Fax driver on the Windows 2000/Windows XP/Windows Vista/Windows 
7/Windows Server 2003/Windows Server 2008 for each language version by Add Printer Wizard or Plug and Play.
[Client Utilities CD-ROM]:\Client\Drivers\FAX\XP_VISTA_X64\<language>\
This includes the setup files to install the N/W-Fax driver on the Windows XP/Windows Vista/Windows 7/Windows 
Server 2003/Windows Server 2008 64-bit edition for each language version by Add Printer Wizard or Plug and Play.

AddressBook Viewer
[Client Utilities CD-ROM]:\Client\ADRBK\32\
This includes the setup files to install the AddressBook Viewer on the Windows 2000/Windows XP/Windows Vista/
Windows 7/Windows Server 2003/Windows Server 2008.
[Client Utilities CD-ROM]:\Client\ADRBK\64\
This includes the setup files to install the AddressBook Viewer on the Windows XP/Windows Vista/Windows 7/
Windows Server 2003/Windows Server 2008 64-bit edition.
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Remote Scan drivers
[Client Utilities CD-ROM]:\Client\RS\
This includes the setup files to install the Remote Scan driver.

TWAIN drivers
[Client Utilities CD-ROM]:\Client\TWAIN\
This includes the setup files to install the TWAIN driver.

File Downloader
[Client Utilities CD-ROM]:\Client\FD\
This includes the setup files to install the File Downloader.

TOSHIBA NDPS Gateway
[Client Utilities CD-ROM]:\Admin\NDPS Gateway\
TOSHIBA NDPS Gateway enable to configure the NDPS objects in servers running NetWare 5.1 with Support Pack 7 
or higher, or NetWare 6.0/6.5.

For Macintosh
The contents of the Client Utilities CD-ROM:

Macintosh PPD files
[Client Utilities CD-ROM]:MacPPD:OSX:10_2-10_3
This includes the PPD file to enable printing from Macintosh on the Mac OS X 10.2.4 to Mac OS X 10.3.x.
[Client Utilities CD-ROM]:MacPPD:OSX:10_4-
This includes the PPD file to enable printing from Macintosh on the Mac OS X 10.4 or later. In addition, this includes 
plug-ins used for Macintosh on the Mac OS X 10.4 or later.

For UNIX/Linux
The contents of the Client Utilities CD-ROM:

Solaris filter
[Client Utilities CD-ROM]/Admin/SolarisFilter/Usa/
This includes the tar file for Solaris v2.6/2.7/7.8/8/9.

HP-UX filter
[Client Utilities CD-ROM]/Admin/HP-UXFilter/Usa/
This includes the tar file for HP-UX ver.10.20/11.x and HP-UX64 ver.11.31.

AIX filter
[Client Utilities CD-ROM]/Admin/AIXFilter/Usa/
This includes the tar file for AIX 4.3.3.

Linux filter
[Client Utilities CD-ROM]/Admin/LinuxFilter/Usa/
This includes the tar file for Red Hat 7.x/8.x/9.x, Red Hat Enterprise WS2, SuSE Linux 7.x/8.x/9.x, Mandrake Linux 7.x/
8.x/9.x and Turbolinux 8/10.

SCO UNIX filter
[Client Utilities CD-ROM]/Admin/OpenUnixFilter/Usa/
This includes the tar file for SCO UnixWare 7 and SCO Open UNIX 8.

CUPS PPD file
[Client Utilities CD-ROM]/Admin/CUPS/Usa/
This includes the PPD file to enable printing from CUPS.
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Contents of Installer

The following software can be installed by the Installer in the Client Utilities CD-ROM.

Printer drivers (Printing function)
Printer drivers are software components that enable application programs to interact with the TOSHIBA MFP. The 
TOSHIBA MFP comes with PCL6, PCL5c, PS3 (PostScript) and XPS printer drivers. These printer drivers offer document 
print, layout and assembly functions that are not available with many applications.

The XPS printer driver can be installed on Windows Vista/Windows 7 computers, or those of Windows XP SP2, 
Windows Server 2003 SP1 or later versions with XPS Essentials Pack installed.

TWAIN driver (Scanning function)
This software component enables you to import e-Filing documents into TWAIN-compliant applications.

File Downloader
This software component enables you to import e-Filing documents into your hard disk.

Remote Scan driver (Scanning function)
This software allows you to perform scanning the originals set in the equipment remotely from a client computer and 
acquire the image into the TWAIN-compliant application.

N/W-Fax driver (Printing function)
The N/W-Fax driver enables you to set up send lists and send electronic documents from your client computer to one or 
more destinations. You print to the fax much the same way you would choose to print to a designated printer that makes 
using the N/W-Fax driver quick and simple. You can select the fax properties.

AddressBook Viewer
With the AddressBook Viewer you can easily add or modify fax recipient names, fax numbers, and Internet Fax address 
(Email address) to the address book. This utility allows you to manage recipients of the fax, select and display fax 
recipients from the address book, as well as recipient fax numbers and other contact information.
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Precautions for changing SNMP Community Name

To print or send jobs normally, the SNMP community names must be the same in the following 3 settings. For help, consult 
the administrator.

1. Your TOSHIBA MFP

2. [SNMP Settings] dialog box

3. TCP/IP port of the [Ports] tab in the printer driver/N/W-Fax driver

When the SMB port is used, the SNMP community name must be the same in your TOSHIBA MFP and the [SNMP 
Settings] dialog box.
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Before Installation

This section will help you to plan an installation suited to your environment. Before installing the printer driver, read this 
section.

When same printer drivers have been installed previously
Before updating the printer drivers, delete the existing printer drivers.

 P.61 “Uninstalling Printer Drivers”

Type of printer drivers
PCL6 printer driver — This printer driver is suitable for printing from a general application, such as word processing 
or calculation.
PCL5c printer driver — This printer driver is suitable for color printing from a general application, such as word 
processing or calculation.
PS3 printer driver — This printer driver is suitable for printing from a general application, such as word processing or 
calculation, and a DTP application supporting PostScript.
XPS printer driver — This printer driver is suitable for printing from an application developed exclusively for Windows 
Vista, such as Windows Presentation Foundation (WPF).

The XPS printer driver can be installed on Windows Vista/Windows 7 computers, or those of Windows XP SP2, 
Windows Server 2003 SP1 or later versions with XPS Essentials Pack installed.

System requirements
To install the printer drivers and other client software on a Windows computer, the following is required.

Display resolution
1024 x 768 dots or more
Display color
High Color (16 bit) or higher is recommended
CPU
Pentium 133 MHz minimum (Pentium 266 MHz or faster recommended)
Memory
The required memory size for OS.
OS
Windows 2000 Service Pack 4
Windows XP Service Pack 2 or later
Windows Vista Service Pack 1 or later
Windows 7
Windows Server 2003 Service Pack 2
Windows Server 2008 Service Pack 1 or later

For details on printer drivers for Windows 2000, Windows XP, Windows Vista, Windows Server 2003 and Windows 
Server 2008, refer to the following section.

 “Printing Guide” - “About client software for Windows”
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About installation procedure for Windows 7
Find the installation procedure suited to your environment from the following:

For details on how to install printer drivers for Windows 2000, Windows XP, Windows Vista, Windows Server 2003 and 
Windows Server 2008, refer to the following section.

 “Printing Guide” - “About client software for Windows”

Parallel Port Connection

When this equipment is connected to your computer with a printer cable, you can install the printer drivers from the Client 
Utilities CD-ROM and set up the printer connection with LPT1 port.

 P.17 “Installing the Printer Drivers for Parallel Printing”

Parallel printing is available only when the optional Parallel Interface is installed.
This equipment cannot be connected to the same computer with both Parallel and USB at a same time.

USB Connection

This equipment supports the Full Speed connection. When this equipment is connected to your computer with the USB 
cable, you must install the printer drivers using the Windows Plug and Play functions.

 P.26 “Installing the Printer Drivers for USB Printing”

This equipment cannot be connected to the same computer with both Parallel and USB at a same time.

Raw TCP/LPR printing
This equipment supports the Raw TCP and LPR printing via TCP/IP. When this equipment is connected to your computer 
in a TCP/IP network, Raw TCP/LPR printing may be most suitable.

 P.32 “Installing the Printer Drivers for Raw TCP/LPR Printing”

To print with a Raw TCP connection, this equipment must be configured to enable Raw TCP Print Service. Ask 
your administrator if the Raw TCP Print Service is enabled.
To print with a LPR connection, this equipment must be configured to enable LPD Print Service. Ask your 
administrator if the LPD Print Service is enabled.

Windows 2000
Windows XP
Windows Vista 
Windows 7

Connecting with Parallel cable

Setting up the LPT1 Printer
Connection Windows Server 2008

Windows Server 2003

Connecting with USB

Setting up the USB Printer
Connection 

Windows 2000
Windows XP
Windows Vista 
Windows 7

Windows Server 2008
Windows Server 2003
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Internet printing
If you print to this equipment over the Internet, you can use IPP printing. This allows you to print to this equipment from 
anywhere on the Internet.

 P.50 “Installing the Printer Drivers for IPP Printing”

To print with an IPP connection, this equipment must be configured to enable the IPP Print Service and must be 
connected to the Internet. Ask your administrator if the IPP Print Service is enabled.

Web Service Print
When this equipment is connected in a TCP/IP network, Web Services Print can be operated at the client computer using 
the function of Windows Vista/Windows 7/Windows Server 2008.

 P.56 “Web Service Print”

Web Services Print is the function of Windows Vista/Windows 7/Windows Server 2008.
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Installing the Printer Drivers for Parallel Printing

This section describes how to install the client software when this equipment is connected with a printer cable.

There are two ways to set up the printer drivers for parallel printing:
Using the installer in the Client Utilities CD-ROM
When you insert the Client Utilities CD-ROM into your CD-ROM drive, the installer automatically starts. You can install 
printer drivers and other client software using the installer. If you want to install printer drivers as well as other client 
software, this method is convenient.

 P.17 “Installation Using the Installer”
Using Add Printer Wizard
When you want to install different printer drivers after installing a printer driver using Plug and Play, or when you want 
to install the printer drivers without using the installer or Plug and Play, install the printer drivers using the Add Printer 
Wizard.

 P.21 “Installation by Add Printer Wizard”

Installation Using the Installer

To perform installation, you must log onto Windows with a user account, which enables the installation and 
uninstallation of client software, such as “Administrators” or “Power Users”.
If Windows 7 is used, you can perform the installation by temporarily changing the user account following the 
procedure below.
- Open the “e-STUDIO” folder in a CD-ROM, and then double-click “Setup.exe”.
- When the [User Account Control] dialog box is displayed, enter the password of “Administrators”, and then click 

[OK] ([Yes]).

1 Insert the Client Utilities CD-ROM into the CD-ROM drive.
If the installer does not automatically start, use the Explorer to open the e-STUDIO folder in the Client Utilities CD-
ROM and double-click “Setup.exe.”

2 Select “I agree to the terms of the License Agreement.” and click [Next].

To change the display language, select a desired language from the Select Language drop-down menu.
The main menu window is displayed.
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3 Select a menu; to install printer drivers, select “Recommended,” “Printer Driver,” or 
“Custom Install.”

Recommended: Select this to install all the drivers and utilities included in the CD-ROM. If you select this menu, 
skip to Step 5.
Printer Driver: Select this to install the printer driver only. If you select this menu, skip to Step 5.
Custom Install: Select this if you would like to pick and choose the installation components. If you select this 
menu, proceed to Step 4.

In addition to the above menus, the main menu window has the Scan Driver and Utilities and the Fax Driver 
menus. For more information about these drivers and utilities, please see the Scanning Guide, the e-Filing 
Guide, and the Network Fax Guide.

4 If you have selected “Custom Install” in Step 3, check the software that you want to 
install and click [Next].

For the printer drivers, refer to the following:
 P.14 “Type of printer drivers”

There are also scan software, e-Filing software, and Fax software in the list. For more information about each 
software, please see the Scanning Guide, the e-Filing Guide, and the Network Fax Guide.
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5 Confirm the list of the software to install and click [Install].

If you install AddressBook Viewer and/or File Downloader, you can change the folder where these programs are 
installed. Click [Browse] and, when the Browse For Folder dialog box appears, select a folder and click [OK].

If the following message appears, click [Continue] to proceed with the operation.

6 Select “Local Port” option and select “LPT1:” in the drop down menu. Then click [OK].

The installation starts.

If the following message appears, click [Yes] to set the indicated printer driver to be the default printer driver, or 
click [No] to not change the default printer driver.
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7 When the installation is complete, click [Finish].

The main menu window is displayed.

The Installer may ask you to restart your computer. If it does, select “Yes, I want to restart my computer now.” 
and click [Finish] to restart your computer.

8 Click [Exit].
When a message appears asking whether to finish the installation, click [Yes].

Before printing using the printer driver, configure the installed options of the equipment and department code (if 
required) on the printer driver.

 P.132 “Before Using the Printer Driver”
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Installation by Add Printer Wizard

The Font Manager is also available to install and manage the TrueType fonts on your computer. To install the Font 
Manager, you must install it from the Client Utilities CD-ROM separately.

To perform installation, you must log onto Windows with a user account, which enables the installation and 
uninstallation of client software, such as “Administrators” or “Power Users”. If Windows 7 is used, you can perform the 
installation by temporarily changing the user account with its User Account Control function. Ask your administrator for 
the details.

1 Click [Start] and then [Devices and Printers] to open the Devices and Printers folder.

2 Click [Add a printer].

The Add Printer dialog box appears.

3 Select [Add a local printer] and click [Next].
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4 Select “LPT1:(Printer Port)” in the “Use an existing port” drop down box. Then click 
[Next].

5 Click [Have Disk...].

The Install From Disk dialog box appears.

6 Click [Browse...].

The Locate File dialog box appears.

7 Insert the Client Utilities CD-ROM into the CD-ROM drive.
When inserting the Client Utilities CD-ROM, the installer may automatically start. Click [Cancel] to exit the installer 
and continue the operation.
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8 Open the folder where the printer driver for Windows 7 is located, and select an INF file, 
and then click [Open].

To install the PCL6 printer driver, locate 
"[Client Utilities CD-ROM]:\Client\Drivers\PCL6\W2K_XP_VISTA\<language>".
To install the PCL5c printer driver, locate 
"[Client Utilities CD-ROM]:\Client\Drivers\PCL5c\W2K_XP_VISTA\<language>".
To install the PS3 printer driver, locate 
"[Client Utilities CD-ROM]:\Client\Drivers\PS\W2K_XP_VISTA\<language>".
To install the XPS printer driver, locate
"[Client Utilities CD-ROM]:\Client\Drivers\XPS\W2K_XP_VISTA\<language>".

When using Windows 7 64-bit edition, select the following folder.
To install the PCL6 printer driver, locate 
"[Client Utilities CD-ROM]:\Client\Drivers\PCL6\XP_VISTA_X64\<language>".
To install the PCL5c printer driver, locate 
"[Client Utilities CD-ROM]:\Client\Drivers\PCL5c\XP_VISTA_X64\<language>".
To install the PS3 printer driver, locate 
"[Client Utilities CD-ROM]:\Client\Drivers\PS\XP_VISTA_X64\<language>".
To install the XPS printer driver, locate 
"[Client Utilities CD-ROM]:\Client\Drivers\XPS\XP_VISTA_X64\<language>".

9 Click [OK].



2 INSTALLING PRINTER DRIVERS FOR WINDOWS

24    Installing the Printer Drivers for Parallel Printing

10 Select the printer driver and click [Next].

If the same printer driver has been installed, the following dialog box appears. Select “Replace the current 
driver” and click [Next].

11 Change the name if desired and click [Next].
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12 Click [Finish].

Click [Print a test page] to print a test page.

If any printer drivers have been installed on your computer, the following dialog box appears. Please select 
whether you will use this printer as a default printer.

13 The installation is completed.

Before printing using the printer driver, configure the installed options of the equipment and department code (if 
required) on the printer driver.

 P.132 “Before Using the Printer Driver”
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Installing the Printer Drivers for USB Printing

This section describes how to set up the printer drivers when this equipment is connected with USB cable.

Installation by Connecting the Equipment

To perform installation, you must log onto Windows with a user account, which enables the installation and 
uninstallation of client software, such as “Administrators” or “Power Users”. If Windows 7 is used, you can perform the 
installation by temporarily changing the user account with its User Account Control function. Ask your administrator for 
the details.

1 Power on this equipment and your computer.

2 Connect this equipment to your computer with the USB cable.

When the Driver Software Installation dialog box appears, click [Close].

3 Insert the Client Utilities CD-ROM into the CD-ROM drive.
The installer automatically starts and the Choose Setup Language dialog box appears.
When the installer does not automatically start, double-click “Setup.exe” in the Client Utilities CD-ROM.

4 Select your language and click [OK].

The Welcome to the InstallShield wizard screen is displayed.

5 Click [Next].

The License Agreement screen is displayed.
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6 Select “I agree to the terms of the License Agreement.” and click [Next].

The main menu window is displayed.

To change the display language, select a desired language from the Select Language drop-down menu.

7 Select a menu; to install printer drivers, select “Recommended,” “Printer Driver,” or 
“Custom Install.”

Recommended: Select this to install all the drivers and utilities included in the CD-ROM. If you select this menu, 
skip to Step 9.
Printer Driver: Select this to install the printer driver only. If you select this menu, skip to Step 9.
Custom Install: Select this if you would like to pick and choose the installation components. If you select this 
menu, proceed to Step 8.

In addition to the above menus, the main menu window has the Scan Driver and Utilities and the Fax Driver 
menus. For more information about these drivers and utilities, please see the Scanning Guide, the e-Filing 
Guide, and the Network Fax Guide.
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8 If you have selected “Custom Install” in Step 7, check the software that you want to 
install and click [Next].

For the printer driver, refer to the following:
 P.14 “Type of printer drivers”

There are also scan software, e-Filing software, and Fax software in the list. For more information about each 
software, please see the Scanning Guide, the e-Filing Guide, and the Network Fax Guide.

9 Confirm the list of the software to install and click [Install].

If you install AddressBook Viewer and/or File Downloader, you can change the folder where these programs are 
installed. Click [Browse] and, when the Browse For Folder dialog box appears, select a folder and click [OK].

10 Since the result message of the detection is displayed, click [Continue].
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11 Select “USBxxx” (xxx are numbers) in the “Local Port” drop down box, and click 
[Next].

12 Click [Next].

If you want to change the program folder, rename the folder in the “Program Folder” field. 

The Start Copying Files screen is displayed. 
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13 Click [Next].

Starts copying files and the InstallShield Wizard Complete screen appears when this is completed.

If the Digital Signature Not Found dialog box is displayed while files are being copied, click [Yes] to continue 
the installation.
If the following message appears, click [Yes] to set the indicated printer driver to be the default printer driver, 
or click [No] to not change the default printer driver.

14 When the installation is complete, click [Finish].

The main menu window is displayed.

The Installer may ask you to restart your computer. If it does, select “Yes, I want to restart my computer now.” 
and click [Finish] to restart your computer.
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15 Click [Exit].
When a message appears asking whether to finish the installation, click [Yes].

Before printing using the printer driver, configure the installed options of the equipment and department code (if 
required) on the printer driver.

 P.132 “Before Using the Printer Driver”

When a printer driver (e.g. PCL6) is installed by means of the above procedure, the “USB001 Virtual print port” 
is created. If you want to install a second driver (e.g. PS3), use “Add Printer Wizard” and add the printer driver 
in the Client Utility CD-ROM to this port. (To start the wizard: Click [Start] and select [Devices and Printers], and 
then click [Add a printer].)
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Installing the Printer Drivers for Raw TCP/LPR Printing

This section describes how to set up the printer drivers for Raw TCP/LPR printing which is available for the local area 
network over TCP/IP.

Installation Using the Installer

To perform installation, you must log onto Windows with a user account, which enables the installation and 
uninstallation of client software, such as “Administrators” or “Power Users”.
If Windows 7 is used, you can perform the installation by temporarily changing the user account following the 
procedure below.
- Open the “e-STUDIO” folder in a CD-ROM, and then double-click “Setup.exe”.
- When the [User Account Control] dialog box is displayed, enter the password of “Administrators”, and then click 

[OK] ([Yes]).

1 Insert the Client Utilities CD-ROM into the CD-ROM drive.
If the installer does not automatically start, use the Explorer to open the “e-STUDIO” folder in the Client Utilities 
CD-ROM and double-click “Setup.exe”.

2 Select [I agree to the terms of the License Agreement.] and click [Next].

To change the display language, select a desired language from the [Select Language] box.
The main menu is displayed.

3 Click [Printer Driver].

A list for software to be installed is displayed.
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4 Confirm the list of the software to install and click [Install].

Installation starts.

Click [SNMP Settings] if a community name other than "public" (default) is set for the SNMP community name 
for your TOSHIBA MFP.
When the [SNMP Settings] dialog box appears, change the SNMP community name and click [OK].
When you change the SNMP community name, see the following page:

 P.11 “Precautions for changing SNMP Community Name”

5 Configure the printer port.
 P.34 “Searching your TOSHIBA MFP automatically”
 P.36 “If your TOSHIBA MFP is not found”
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Searching your TOSHIBA MFP automatically
This equipment is automatically discovered over the network. Then you can install printer driver so as to configure the 
Raw TCP/LPR port.

If this equipment is not discovered over the network after the installation is started, a dialog box indicating this appears. 
Follow the procedure below to continue the configuration.
- To search this equipment over the network again, click [Retry].
- Confirm the SNMP community name in the [SNMP Settings] dialog box.
- To select a temporary local port and then configure the Raw TCP/LPR port, click [Continue]. Then follow the 

procedure as described in the following page:
 P.36 “If your TOSHIBA MFP is not found”

6 A list for the discovered printers is displayed. Then select this equipment on the list 
and then click [OK].

The TCP/IP port is created.
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Searching may take a while depending on the Windows OS or network environment.
If a dialog box prompting you to confirm the setting of a printer for normal use appears, click [Yes] or [No].

If the [Windows Security] dialog box appears, click [Install this driver software anyway].

7 Confirm that the installation is completed, and then click [Finish].

The Installer may ask you to restart your computer. If it does, select “Yes, I want to restart my computer now.” 
and click [Finish] to restart your computer.

8 Click [Exit].
When a message appears asking whether to finish the installation, click [Yes].

Before using the printer driver for printing, configure the installed options of the equipment and department 
code (if required) on the printer driver. Refer to the Printing Guide for the instructions.
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If your TOSHIBA MFP is not found
If your TOSHIBA MFP is not found, you must first install the printer driver by temporarily selecting a local port and then 
configuring the Raw TCP/LPR port.

If this equipment is not discovered over the network after the installation is started, a dialog box indicating this appears. 
Click [Continue] to continue the configuration.

6 Select [Local Port] and then select “LPT1: ”. Then click [OK].

If a dialog box prompting you to confirm the setting of a printer for normal use appears, click [Yes] or [No].

If the [Windows Security] dialog box appears, click [Install this driver software anyway].
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7 Confirm that the installation is completed, and then click [Finish].

The Installer may ask you to restart your computer. If it does, select “Yes, I want to restart my computer now.” 
and click [Finish] to restart your computer.

8  Click [Exit].
When a message appears asking whether to finish the installation, click [Yes].

9 Click [Start] and then [Devices and Printers] to open the Devices and Printers folder.
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10 Right-click on the printer driver icon, and then select [Printer properties] from the 
menu.

For Windows 7, some tab menus have a  button in the printer driver properties. To change the properties, 
click on it. If the properties cannot be changed, ask your system administrator.
If you have logged onto Windows Vista/Windows 7/Windows Server 2008 with a user account other than 
“Administrators”, continue the installation following the procedure below.
- Right-click on a printer driver of this equipment, and select [Run as administrator] - [Properties].
- When the [User Account Control] dialog box is displayed, enter the password of “Administrators”, and then 

click [OK] ([Yes]).
The printer driver properties dialog box appears.

As more than one printer driver is installed simultaneously, it is necessary to configure a printer port for each 
printer driver. Repeat the configuration procedure from the steps shown below.

11 Click the [Ports] tab and click [Add Port].

The [Printer Ports] dialog box appears.
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12 Select [Standard TCP/IP Port] and click [New Port].

The [Add Standard TCP/IP Printer Port Wizard] dialog box appears.

13 Click [Next].

14 Enter the IP address of this equipment in the [Printer Name or IP Address] box and 
click [Next].

If your network uses a DNS or WINS server, enter the printer name of this equipment provided from DNS or 
WINS in the [Printer Name or IP Address] box.
In the [Port Name] box, the port name is automatically entered according to the IP address or DNS name 
entered in the [Printer Name or IP Address] box. 
Enter the IPv6 address in the [Printer Name or IP Address] box when the MFP is connected in an IPv6 network.
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When the following dialog box is displayed on Windows 7, select [Standard] and click [Next].

15 Click [Finish].

The screen returns to the [Printer Ports] dialog box.

16 Click [Close] to close the [Printer Ports] dialog box.
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17 Make sure the created Raw TCP or LPR port is checked in the [Print to the following 
port(s)] list.

When the LPD Print setting is enabled, you can also configure LPR printing. When you want to configure LPR 
printing, follow the procedure below.
1. Click [Configure Port].

2. Select [LPR] at the [Protocol] group, enter “print” in the [Queue Name] box at the [LPR Settings] group, and 
then click [OK].
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18 Click [Close] to save the setting.

Before using the printer driver for printing, configure the installed options of the equipment and department 
code (if required) on the printer driver. Refer to the Printing Guide for the instructions.
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Installation by Add Printer Wizard

The Font Manager is also available to install and manage the TrueType fonts on your computer. To install the Font 
Manager, you must install it from the Client Utilities CD-ROM separately.

To perform installation, you must log onto Windows with a user account, which enables the installation and 
uninstallation of client software, such as “Administrators” or “Power Users”. If Windows 7 is used, you can perform the 
installation by temporarily changing the user account with its User Account Control function. Ask your administrator for 
the details.

1 Click [Start] and then [Devices and Printers] to open the Devices and Printers folder.

2 Click [Add a printer].

The Add Printer dialog box appears.

3 Select [Add a local printer] and click [Next].
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4 Select “Create a new port” and select “Standard TCP/IP Port” in the “Type of port” drop 
down box. Then click [Next].

5 Enter the IP address of this equipment in the “Hostname or IP address” field and click 
[Next].

If your network uses a DNS or WINS server, enter the printer name of this equipment provided from DNS or 
WINS in the “Hostname or IP address” field.
In the “Port name” field, the port name is automatically entered according to the IP address or DNS name 
entered in the “Hostname or IP address” field.
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6 Select “Standard” and click [Next].

When the LPD Print setting is enabled, you can also configure LPR printing. When you want to configure LPR 
printing, follow the procedure below.
You can also select [Printer properties] and set the port with [Configure Port...] in the [Ports] tab by right-clicking 
the printer driver in the [Devices and Printers] folder.

Select “Custom” and click [Settings].

Select “LPR” at the “Protocol” option, enter “Print” in the “Queue Name” field at the “LPR Settings” option, and then 
click [OK].



2 INSTALLING PRINTER DRIVERS FOR WINDOWS

46    Installing the Printer Drivers for Raw TCP/LPR Printing

Click [Next].

7 Click [Have Disk...].

The Install From Disk dialog box appears.

8 Click [Browse...].

The Locate File dialog box appears.

9 Insert the Client Utilities CD-ROM into the CD-ROM drive.
When inserting the Client Utilities CD-ROM, the installer may automatically start. Click [Cancel] to exit the installer 
and continue the operation.
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10 Open the folder where the printer driver for Windows 7 is located, and select an INF file, 
and then click [Open].

To install the PCL6 printer driver, locate 
"[Client Utilities CD-ROM]:\Client\Drivers\PCL6\W2K_XP_VISTA\<language>".
To install the PCL5c printer driver, locate 
"[Client Utilities CD-ROM]:\Client\Drivers\PCL5c\W2K_XP_VISTA\<language>".
To install the PS3 printer driver, locate 
"[Client Utilities CD-ROM]:\Client\Drivers\PS\W2K_XP_VISTA\<language>".
To install the XPS printer driver, locate
"[Client Utilities CD-ROM]:\Client\Drivers\XPS\W2K_XP_VISTA\<language>".

When using Windows 7 64-bit edition, select the following folder.
To install the PCL6 printer driver, locate 
"[Client Utilities CD-ROM]:\Client\Drivers\PCL6\XP_VISTA_X64\<language>".
To install the PCL5c printer driver, locate 
"[Client Utilities CD-ROM]:\Client\Drivers\PCL5c\XP_VISTA_X64\<language>".
To install the PS3 printer driver, locate 
"[Client Utilities CD-ROM]:Client\Drivers\PS\XP_VISTA_X64\<language>".
To install the XPS printer driver, locate
"[Client Utilities CD-ROM]:\Client\Drivers\XPS\XP_VISTA_X64\<language>".

11 Click [OK].
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12 Select the printer driver and click [Next].

If the same printer driver has been installed, the following dialog box appears. Select “Replace the current 
driver” and click [Next].

13 Change the name if desired and click [Next].
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14 Click [Finish].

Click [Print a test page] to print a test page.

If any printer drivers have been installed on your computer, the following dialog box appears. Please select 
whether you will use this printer as a default printer.

15 The installation is completed.

Before printing using the printer driver, configure the installed options of the equipment and department code (if 
required) on the printer driver.

 P.132 “Before Using the Printer Driver”
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Other Installations

The following printing environments cannot be configured by installation using the Installer. When you want to configure 
the following printing environments, see the following pages for each procedure.

 P.50 “Installing the Printer Drivers for IPP Printing”
 P.56 “Web Service Print”

Installing the Printer Drivers for IPP Printing
This section describes how to set up the printer drivers for IPP printing which is available for Internet connection.
To set up the printer drivers for IPP printing, install the printer drivers by Add Printer Wizard.

Before installing the printer driver for IPP printing, check with your system administrator to make sure of the following:
- This equipment is connected to the network and turned on.
- The TCP/IP setting is correct on this equipment and your computer.

To perform installation, you must log onto Windows with a user account, which enables the installation and 
uninstallation of client software, such as “Administrators” or “Power Users”. If Windows 7 is used, you can perform the 
installation by temporarily changing the user account with its User Account Control function. Ask your administrator for 
the details.

1 Click [Start] and then [Devices and Printers] to open the Devices and Printers folder.

2 Click [Add a printer].

The Add Printer dialog box appears.



2.INSTALLING PRINTER DRIVERS FOR WINDOWS

Other Installations    51

2 INSTALLING PRINTER DRIVERS FOR WINDOWS

3 Select [Add a network, wireless or Bluetooth printer]. 

4 Select [The Printer that I want isn't listed].

5 Select the [Select a shared printer by name] check box, enter “http://[IP address]:631/
Print” in the edit box in [Find by printer name or TCP/IP address] screen.

Enter the IP address of this equipment instead of [IP address].
   Example: IP address = 192.168.1.2

http://192.168.1.2:631/Print
Enter the IPv6 address in the [Printer Name or IP Address] box when the MFP is connected in an IPv6 network.
If your network uses a DNS or WINS server, enter the printer name of this equipment provided from DNS or 
WINS instead of [IP address].
   Example: Print Server Name = Mfp-05212774

http://Mfp-05212774:631/Print
When you connect from the Internet, enter the FQDN of this equipment provided from DNS instead of [IP 
address].
   Example: URL = mfp_05212774.toshibatec.com

http://mfp_05212774.toshibatec.com:631/Print
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“P” for “Print” in the IPP URL must be capitalized. The IPP port can be created by entering “print” (non-
capitalized) in the IPP URL, but the print job cannot be sent to the equipment. In that case, delete the IPP port 
and then create the IPP port correctly again.

If the IPP Port80 Enabled option is enabled on this equipment, you can exclude the port number from the 
URL. (i.e. “http://192.168.1.2/Print”)
If the Enable SSL option for IPP Print is enabled, you must enter “https://[IP address]:[SSL port number]/
Print” in the “URL” field. (i.e. “https://192.168.1.2:443/Print”)

6 Click [Next].
A dialog box appears to confirm the connection with the specified MFP. Wait until completion.

When the Authentication setting for IPP Print is enabled, the dialog box to enter a user name and password 
appears. If this dialog box appears, enter the user name and password and click [OK]. For user name and 
password, ask your administrator.

7 Click [Have Disk].

The [Install From Disk] dialog box appears.
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8 Click [Browse].

The [Locate File] dialog box appears.

9 Insert the Client Utilities CD-ROM into the CD-ROM drive.
When inserting the Client Utilities CD-ROM, the installer may automatically start. Click [Exit] to exit the installer and 
continue the operation.

10 Locate the directory where the printer driver is located, select the inf file, and click 
[Open].

To install the PCL6 printer driver, locate 
“[Client Utilities CD-ROM]:\Client\Drivers\PCL6\W2K_XP_VISTA\<language>”.
To install the PCL5c printer driver, locate 
“[Client Utilities CD-ROM]:\Client\Drivers\PCL5c\W2K_XP_VISTA\<language>”.
To install the PS3 printer driver, locate 
“[Client Utilities CD-ROM]:\Client\Drivers\PS\W2K_XP_VISTA\<language>”.
To install the XPS printer driver, locate
“[Client Utilities CD-ROM]:\Client\Drivers\XPS\W2K_XP_VISTA\<language>”.

When using Windows 7 64-bit edition, select the following folder.
- To install the PCL6 printer driver, locate 

“[Client Utilities CD-ROM]:\Client\Drivers\PCL6\XP_VISTA_X64\<language>”.
- To install the PCL5c printer driver, locate 

“[Client Utilities CD-ROM]:\Client\Drivers\PCL5c\XP_VISTA_X64\<language>”.
- To install the PS3 printer driver, locate 

“[Client Utilities CD-ROM]:\Client\Drivers\PS\XP_VISTA_X64\<language>”.
- To install the XPS printer driver, locate

“[Client Utilities CD-ROM]:\Client\Drivers\XPS\XP_VISTA_X64\<language>”.

11 Click [OK].
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12 Select the printer driver and click [Next].

The [User Account Control] dialog box is displayed.

If any printer drivers have been installed on your computer, the following dialog box appears. Please select 
whether you will use this printer as a default printer.

13 Change the name if desired and click [Next].
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14 Click [Finish].

Click [Print a test page] to print a test page.

If any printer drivers have been installed o your computer, the following dialog box appears. Please select 
whether you will use this printer as a default printer.

15 The installation is completed.

Before printing using the printer driver, configure the installed options of the equipment code (if required) on the 
printer driver.

 P.132 “Before Using the Printer Driver”
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Web Service Print
This equipment supports the WSD (Web Services on Devices) protocol installed in Windows Vista/Windows 7/Windows 
Server 2008. The following descries how to install a printer driver using the WSD protocol.

To perform installation, you must log onto Windows with a user account of “Administrators”. However, even if you 
have logged on with a user account other than “Administrators”, entering the password of “Administrators” upon 
display of the [User Account Control] dialog box enables you to perform the installation by temporarily changing the 
user account.
A driver for Web Services Scanning is automatically installed as well as the client software.

Once the printer driver is installed from the Client Utilities CD-ROM, you will no longer need the CD-ROM for the 
installation of the Web Service Print because the printer driver data will remain.
For the uninstallation procedure of the printer driver, see the following: 

 P.61 “Uninstalling Printer Drivers”

1 Click [Start] and then select [Computer] to open the computer folder.

2 Click [Network].

The [Network] screen is displayed.
Go to Step 5 if the Network discovery is enabled.
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3 Click [Network discovery and file sharing are turned off. Network computers and 
devices are not visible. Click to change]. Then select [Turn on network discovery and 
file sharing].

The [User Account Control] dialog box appears. 
If User Account Control is disabled, the Network discovery and file sharing screen is displayed. Go to Step 5. 

4 Click [Continue] in the [User Account Control] dialog box. 
If you have logged on with a user account other than “Administrators”, enter the password of “Administrators” 
and then click [OK] ([Yes]).
After the Network discovery is enabled, go to step 5.

5 Click [Yes, turn on network discovery and file sharing for all public networks]. 

Connected computers and icons of the multifunction devices are displayed in the [Network] screen. 

This procedure must be performed only when User Account Control is disabled. Operation cannot be made 
with a user account other than “Administrators”.
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6 Select the icon of the multifunction device of the equipment and right-click to make the 
menu appear, then click [Install].

You can display only the multifunction devices by checking [Multifunction Devices] on the [Category] box.

[PnPX Device Association] is displayed on the task bar.
If User Account Control is disabled, [Found New Hardware] is displayed on the task bar. 
Go to Step 8. 

7 Click [PnPX Device Association] on the task bar. 

The [User Account Control] dialog box appears.

8 Click [Continue] in the [User Account Control] dialog box. 
If you have logged on with a user account other than “Administrators”, enter the password of “Administrators” 
and then click [OK] ([Yes]).
The [Found New Hardware] dialog box appears.

You can check the current installing status by clicking a balloon message at the bottom right of the screen.

9 Click [Locate and install driver software (recommended)].

The [Found New Hardware - Unknown Device] dialog box appears.

When the [User Account Control] dialog box is displayed, click [Continue] to continue the installation. 
However, if you have logged on with a user account other than “Administrators”, enter the password of 
“Administrators” and then click [OK] ([Yes]).
When the confirmation dialog box for online search is displayed, click [Don’t search online].
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10 Click [Browse my computer for driver software (advanced)].

11 Set the Client Utilities CD-ROM to the CD-ROM drive, click [Browse] to specify the 
position of the CD-ROM drive and then click [Next].

When inserting the Client Utilities CD-ROM, the installer may automatically start. Click [Exit] to exit the installer and 
continue the operation.

12 Select the printer driver (each language) to be installed, and then click [Next].

When the [Windows Security] dialog box is displayed, click [Install this driver software anyway] to continue the 
installation.
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13 The installation is completed. Click [Close].
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Uninstalling Printer Drivers

The following instructions describe how to uninstall the client software.

1 Open the [Devices and Printers] folder, right-click on the printer to be deleted and 
select [Remove device] from the menu displayed.
When the confirmation dialog box for deletion is displayed, click [Yes].

2 Select one of the remaining printer icons and click [Print server properties].

The [User Account Control] dialog box appears.

3 Click [Continue] in the [User Account Control] dialog box.
If you have logged on with a user account other than “Administrators”, enter the password of “Administrators” 
and then click [OK] ([Yes]).
The [Print Server Properties] dialog box appears.

4 Click [Drivers] tab and click [Change Driver Settings].
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5 Display the [Drivers] tab and select the printer drivers to be deleted. Then click 
[Remove].

The [Remove Driver And Package] dialog box appears.

6 Select [Remove driver and driver package] and click [OK].

The [Print Server Properties] dialog box appears.

7 Click [Yes].

The “Driver package information collected.” message is displayed.

8 Click [Delete].

The “Driver package deleted.” message is displayed.
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9 Click [OK].

10 Close the [Print Server Properties] dialog box.
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About the Installation

Refer to following instructions for configuring printing systems on Macintosh computers.
 P.66 “About client software for Macintosh”
 P.66 “Planning for installation”
 P.67 “Installing the Printer on Mac OS X 10.2.4 to Mac OS X 10.6.x”

About client software for Macintosh

PostScript Printer Description file
The Macintosh PPD (PostScript Printer Description) file contains information about controller-specific features.
Two PPD files are provided: one is for Macintosh on the Mac OS X 10.2.4 to Mac OS X 10.3.x, the other is for Macintosh 
on the Mac OS X 10.4 or later. In addition, plug-ins are provided, which are used for Macintosh on the Mac OS X 10.4 or 
later.

Planning for installation

System requirements
To install the printer drivers on a Mac OS computer, the following environment is required.
Display resolution: 1028 x 768 dots or more
OS: Mac OS X 10.2.4 to Mac OS X 10.6.x
Protocol: TCP/IP, AppleTalk (Ethernet), Bonjour

To use printer drivers, the printing function is required.
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Install and configure the printer by the following pages:
 P.67 “Installing the Macintosh PPD file”
 P.71 “Installing plug-ins (Mac OS X 10.4 or later)”
 P.75 “Options”
 P.78 “Configuring the printer on Mac OS X 10.6.x”
 P.84 “Configuring the printer on Mac OS X 10.5.x”
 P.90 “Configuring the printer on Mac OS X 10.4.x”
 P.96 “Configuring the printer on Mac OS X 10.2.4 to 10.3.x”
 P.103 “Configuring the installable options”

Installing the Macintosh PPD file
This equipment supports printing from Mac OS X 10.2.4 to Mac OS X 10.6.x.
The following describes an installation on Mac OS X 10.5.x. The procedure is the same when other versions of Macintosh 
are used.

1 Insert the Client Utilities CD-ROM into the CD-ROM drive and open the 
“MacPPD:OSX:xxxx” folder.
* “xxxx” is the OS version.

10_2-10_3: This includes the PPD file to enable printing from Macintosh on the Mac OS X 10.2.4 to Mac OS X 10.3.x.
10_4-: This includes the PPD file to enable printing from Macintosh on the Mac OS X 10.4 or later.

2 Copy the GZIP file (TOSHIBA_eSxxxxSeries.dmg.gz) to the desktop.
* “xxxx” is the model name of the TOSHIBA MFP.

3 Double-click the GZIP file on the desktop.
The Disk Image file (TOSHIBA_eSxxxxSeries.dmg) is extracted on the desktop.
If the installer window appears, go to step 5.

4 Double-click the Disk Image file (TOSHIBA_eSxxxxSeries.dmg).
The installer window appears.
* “xxxx” is the model name of the TOSHIBA MFP.

5 Double-click the icon in the installer window.

The installer starts.

When you install the PPD file to Mac OS X 10.2.4 to 10.2.8, the [Authenticate] dialog box appears. In that 
case, enter the name and password and click [OK].
When you start up the installer, be sure that Mac OS Printer Setup Utility is not operating. If a PPD file is 
installed while the Mac OS Printer Setup Utility is operating, the printer may not be normally recognized.
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6 Click [Continue].

The [Software License Agreement] window is displayed.

7 Click [Continue].

8 Click [Agree].

The [Standard Install] window is displayed.
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9 Click [Install] (or [Upgrade]).

The [Authenticate] dialog box appears.

The Select a Destination dialog box appears by clicking [Change Install Location]. Select the boot disk for Mac 
OS X and click [Continue].

10 Enter the name and password, and click [OK].

It starts copying the PPD files for each language.

When you install the PPD file to Mac OS X 10.2.4 to 10.2.8, the [Authenticate] dialog box does not appear in 
this step.
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11 Click [Close] to close the installer window.

12 Delete the GZIP files and Installer files created on the desktop.

13 Continue the procedure for installing plug-ins and configuring the printer.
 P.71 “Installing plug-ins (Mac OS X 10.4 or later)”
 P.78 “Configuring the printer on Mac OS X 10.6.x”
 P.84 “Configuring the printer on Mac OS X 10.5.x”
 P.90 “Configuring the printer on Mac OS X 10.4.x”
 P.96 “Configuring the printer on Mac OS X 10.2.4 to 10.3.x”
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Installing plug-ins (Mac OS X 10.4 or later)
This section describes how to install plug-ins used for Mac OS X 10.4 or later.

When installing them, you can use the following functions:
Watermark
This function allows you to print a watermark such as [Confidential], [Draft], [Proof] or [Top Secret] over a document.
e-Filing
This function allows you to store print jobs in e-Filing on this equipment.

For details on watermarks and e-Filing, refer to the Printing Guide.

The following describes an installation on Mac OS X 10.5.x. The procedure is the same when other versions of Macintosh 
are used.

1 Insert the Client Utilities CD-ROM into the CD-ROM drive and open the 
“MacPPD:OSX:10_4-” folder.

2 Copy the GZIP file (TOSHIBA_eS-Ex_Features.dmg.gz) to the desktop.

3 Double-click the GZIP file on the desktop.
The Disk Image file (TOSHIBA_eS-Ex_Features.dmg) is extracted on the desktop.
If the installer window appears, go to step 5.

4 Double-click the Disk Image file (TOSHIBA_eS-Ex_Features.dmg).
The installer window appears.

5 Double-click the icon in the installer window.

The installer starts.

6 Click [Continue].

The [Software License Agreement] window is displayed.
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7 Click [Continue].

8 Click [Agree].

The [Standard Install] window is displayed.
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9 Click [Install].

The [Authenticate] dialog box appears.

If you want to choose a custom installation, click [Customize]. In the [Custom Install] window, disable either 
“Watermark” or “e-Filing” and click [Install].

10 Enter the name and password, and click [OK].

It starts installing plug-ins.
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11 Click [Close] to close the installer window.

12 Delete the GZIP files and Installer files created on the desktop.
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Options
Options vary depending on your models. Configure options from [Configuring the printer] referring to the following table.

e-STUDIO850 Series /e-STUDIO853 Series

e-STUDIO452 Series / e-STUDIO453 Series

Finisher Not Installed Select this if a finisher is not installed.

Multi-Position Stapler Select this when the Finisher or Saddle Stitch Finisher is installed.

Multi-Position Stapler and 
Hole Punch

Select this when the Finisher or Saddle Stitch Finisher and Hole Punch unit are 
installed.

The finisher options such as stapling and hole punching can be selected even if you select "Not Installed" for 
the Finisher option. If you select the finisher options for printing but the finisher is not installed, finisher settings 
will be ignored and perform printing correctly.

Drawers Not Installed Select this when no optional drawer is installed.

Drawer Select this when the Drawer 3 and 4 are installed.

LCF Select this when the LCF is installed.

LCF is not available for some countries or regions.

External LCF Not Installed Select this when the External LCF is not installed.

Installed Select this when the External LCF is installed.

Finisher Not Installed Select this if a finisher is not installed.

Single-Position Stapler Select this when the Hanging Finisher is installed.

Multi-Position Stapler Select this when the Finisher or Saddle Stitch Finisher is installed.

Multi-Position Stapler and 
Hole Punch

Select this when the Finisher or Saddle Stitch Finisher and Hole Punch unit are 
installed.

Job Separator Select this when the Job Separator is installed.

Offset Stacker Select this when the Offset Stacker is installed.

The finisher options such as stapling and hole punching can be selected even if you select "Not Installed" for 
the Finisher option. If you select the finisher options for printing but the finisher is not installed, finisher settings 
will be ignored and perform printing correctly.

Drawers Not Installed Select this when no optional drawer is installed.

Drawer 3 Select this when the drawer 3 is installed.

Drawer 3 and 4 Select this when the drawer 3 and 4 are installed.

LCF Select this when the LCF is installed.

LCF is not available for some countries or regions.
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e-STUDIO282 Series / e-STUDIO283 Series

e-STUDIO451c Series

Finisher Not Installed Select this if a finisher is not installed.

Single-Position Stapler Select this when the Hanging Finisher is installed.

Multi-Position Stapler Select this when the Finisher or Saddle Stitch Finisher is installed.

Multi-Position Stapler and 
Hole Punch

Select this when the Finisher or Saddle Stitch Finisher and Hole Punch unit are 
installed.

Job Separator Select this when the Job Separator is installed.

Offset Stacker Select this when the Offset Stacker is installed.

The finisher options such as stapling and hole punching can be selected even if you select "Not Installed" for 
the Finisher option. If you select the finisher options for printing but the finisher is not installed, finisher settings 
will be ignored and perform printing correctly.

Drawers Drawer 1 Select this when the Drawer 1 is installed.

Drawer 1 & LCF Select this when the Drawer 1 and LCF are installed.

Drawer 1 & 3 Select this when the Drawer 1 and Drawer 3 are installed.

Drawer 1,3 & 4 Select this when the Drawer 1, Drawer 3 and Drawer 4 are installed.

Drawer 1 & 2 Select this when the Drawer 1 and Drawer 2 are installed.

Drawer 1,2 & LCF Select this when the Drawer 1, Drawer 2 and LCF are installed.

Drawer 1,2 & 3 Select this when the Drawer 1, Drawer 2 and Drawer 3 are installed.

Drawer 1,2,3 & 4 Select this when the Drawer 1, Drawer2, Drawer 3 and Drawer 4 are installed.

LCF is not available for some countries or regions.

Automatic 
Duplexing Unit

Not Installed Select this when the Automatic Duplexing Unit is not installed.

Installed Select this when the Automatic Duplexing Unit is installed.

Finisher Not Installed Select this if a finisher is not installed.

Single-Position Stapler Select this when the Hanging Finisher is installed.

Multi-Position Stapler Select this when the Finisher or Saddle Stitch Finisher is installed.

Multi-Position Stapler and 
Hole Punch

Select this when the Finisher or Saddle Stitch Finisher and Hole Punch unit are 
installed.

The finisher options such as stapling and hole punching can be selected even if you select "Not Installed" for 
the Finisher option. If you select the finisher options for printing but the finisher is not installed, finisher settings 
will be ignored and perform printing correctly.

Drawers Not Installed Select this when no optional drawer is installed.

Drawer 3 Select this when the drawer 3 is installed.

Drawer 3 and 4 Select this when the drawer 3 and 4 are installed.

LCF Select this when the LCF is installed.

LCF is not available for some countries or regions.
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e-STUDIO3510c Series

Finisher Not Installed Select this if a finisher is not installed.

Multi-Position Stapler Select this when the Finisher or Saddle Stitch Finisher is installed.

Multi-Position Stapler and 
Hole Punch

Select this when the Finisher or Saddle Stitch Finisher and Hole Punch unit are 
installed.

The finisher options such as stapling and hole punching can be selected even if you select "Not Installed" for 
the Finisher option. If you select the finisher options for printing but the finisher is not installed, finisher settings 
will be ignored and perform printing correctly.

Drawers Not Installed Select this when no optional drawer is installed.

Drawer 3 Select this when the drawer 3 is installed.

Drawer 3 and 4 Select this when the drawer 3 and 4 are installed.

LCF Select this when the LCF is installed.

LCF is not available for some countries or regions.
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Configuring the printer on Mac OS X 10.6.x
After you copy the PPD file to the library folder in the System Folder, you can configure the printer.
This equipment supports the following Macintosh Printing Services: LPR Printing, IPP Printing and Bonjour Printing.

LPR printing
When this equipment and your computer are connected over TCP/IP network, you can perform LPR printing from 
Macintosh computer.
IPP printing
When this equipment and your computer are connected over TCP/IP network, you can perform IPP printing from 
Macintosh computer.
Bonjour printing
When this equipment and your computer are connected over TCP/IP network, you can perform Bonjour printing from 
Macintosh computer.

Configuring LPR printing (Mac OS X 10.6.x)

1 Open System Preferences and click [Print & Fax].

2 Click [+].
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3 Click [IP] and specify the items as described below.

Protocol: Line Printer Daemon - LPD
Address: <IP address or DNS name of this equipment>
Queue: print
Name: <Any Name>
Location: <Any Name>
Print Using:  TOSHIBA eSxxxxSeries USA (For North America) / TOSHIBA eSxxxxSeries (For UK)
* “xxxx” is the model name of the TOSHIBA MFP.

In the [Name] box, the name that is entered in the [Address] box is automatically displayed.
The way to select the PPD file differs depending on countries or regions as follows:
- For North America

Even when you enter the IP address or DNS name of this equipment in the [Address] box, the correct 
PPD file is not selected in the [Print Using] box. Therefore, select [Other] in the [Print Using] box, and 
select the PPD file (TOSHIBA_eSxxxxSeries USA) from the [/Library/Printers/PPDs/Contents/
Resources/en.lproj] folder.

- For UK
When you enter the IP address or DNS name of this equipment in the [Address] box, the correct PPD 
file is automatically selected in the [Print Using] box. If the correct PPD is not automatically selected, 
select [Select a driver to use] and select the PPD file displayed in the list.

* “xxxx” is the model name of the TOSHIBA MFP.

4 Click [Add].
The [Installable Options] window appears.

5 Select the options depending on your environment.

Configure options depending on your equipment.
 P.75 “Options”

6 Click [Continue].
The printer is added to the Printer List.
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Configuring IPP printing (Mac OS X 10.6.x)
When you want to setup IPP print queue in the Mac OS X, follow the procedures below.

1 Open System Preferences and click [Print & Fax].

2 Click [+].

3 Click [IP] and specify the items as described below.

Protocol: Internet Printing Protocol - IPP
Address: <IP address or DNS name of this equipment>
Queue: Print
Name: <Any Name>
Location: <Any Name>
Print Using:  TOSHIBA eSxxxxSeries USA (For North America) / TOSHIBA eSxxxxSeries (For UK)
* “xxxx” is the model name of the TOSHIBA MFP.
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In the [Name] box, the name that is entered in the [Address] box is automatically displayed.
The way to select the PPD file differs depending on countries or regions as follows:
- For North America

Even when you enter the IP address or DNS name of this equipment in the [Address] box, the correct 
PPD file is not selected in the [Print Using] box. Therefore, select [Other] in the [Print Using] box, and 
select the PPD file (TOSHIBA_eSxxxxSeries USA) from the [/Library/Printers/PPDs/Contents/
Resources/en.lproj] folder.

- For UK
When you enter the IP address or DNS name of this equipment in the [Address] box, the correct PPD 
file is automatically selected in the [Print Using] box. If the correct PPD is not automatically selected, 
select [Select a driver to use] and select the PPD file displayed in the list.

* “xxxx” is the model name of the TOSHIBA MFP.

4 Click [Add].
The Installable Options window appears.

5 Select the options depending on your environment.

Configure options depending on your equipment.
 P.75 “Options”

6 Click [Continue].
The printer is added to the Printer List.
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Configuring Bonjour printing (Mac OS X 10.6.x)

1 Open System Preferences and click [Print & Fax].

2 Click [+].
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3 Click [Default] and select the TOSHIBA MFP of the Bonjour connection displayed in the 
list.

In the [Name] box, the device name that you selected in the list is automatically displayed.
The way to select the PPD file differs depending on countries or regions as follows:
- For North America

Even when you select the equipment from the list, the correct PPD file is not selected in the [Print Using] 
box. Therefore, select [Other] in the [Print Using] box, and select the PPD file (TOSHIBA_eSxxxxSeries 
USA) from the [/Library/Printers/PPDs/Contents/Resources/en.lproj] folder.

- For UK
When you select the equipment from the list, the correct PPD file is automatically selected in the [Print 
Using] box. If the correct PPD is not automatically selected, select [Select a driver to use] and select the 
PPD file displayed in the list.

* “xxxx” is the model name of the TOSHIBA MFP.

4 Click [Add].
The [Installable Options] window appears.

5 Select the options depending on your environment.

Configure options depending on your equipment.
 P.75 “Options”

6 Click [Continue].
The printer is added to the Printer List.
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Configuring the printer on Mac OS X 10.5.x
After you copy the PPD file to the library folder in the System Folder, you can configure the printer.
This equipment supports the following Macintosh Printing Services: LPR Printing, IPP Printing and Bonjour Printing.

LPR printing
When this equipment and your computer are connected over TCP/IP network, you can perform LPR printing from 
Macintosh computer.
IPP printing
When this equipment and your computer are connected over TCP/IP network, you can perform IPP printing from 
Macintosh computer.
Bonjour printing
When this equipment and your computer are connected over TCP/IP network, you can perform Bonjour printing from 
Macintosh computer.

Configuring LPR printing (Mac OS X 10.5.x)

1 Open System Preferences and click [Print & Fax].

2 Click [+].
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3 Click [IP] and specify the items as described below.

Protocol: Line Printer Daemon - LPD
Address: <IP address or DNS name of this equipment>
Queue: print
Name: <Any Name>
Location: <Any Name>
Print Using:  TOSHIBA eSxxxxSeries USA (For North America) / TOSHIBA eSxxxxSeries (For UK)
* “xxxx” is the model name of the TOSHIBA MFP.

In the [Name] box, the name that is entered in the [Address] box is automatically displayed.
The way to select the PPD file differs depending on countries or regions as follows:
- For North America

Even when you enter the IP address or DNS name of this equipment in the [Address] box, the correct 
PPD file is not selected in the [Print Using] box. Therefore, select [Other] in the [Print Using] box, and 
select the PPD file (TOSHIBA_eSxxxxSeries USA) from the [/Library/Printers/PPDs/Contents/
Resources/en.lproj] folder.

- For UK
When you enter the IP address or DNS name of this equipment in the [Address] box, the correct PPD 
file is automatically selected in the [Print Using] box. If the correct PPD is not automatically selected, 
select [Select a driver to use] and select the PPD file displayed in the list.

* “xxxx” is the model name of the TOSHIBA MFP.

4 Click [Add].
The [Installable Options] window appears.

5 Select the options depending on your environment.

Configure options depending on your equipment.
 P.75 “Options”

6 Click [Continue].
The printer is added to the Printer List.
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Configuring IPP printing (Mac OS X 10.5.x)
When you want to setup IPP print queue in the Mac OS X, follow the procedures below.

1 Open System Preferences and click [Print & Fax].

2 Click [+].

3 Click [IP] and specify the items as described below.

Protocol: Internet Printing Protocol - IPP
Address: <IP address or DNS name of this equipment>
Queue: Print
Name: <Any Name>
Location: <Any Name>
Print Using:  TOSHIBA eSxxxxSeries USA (For North America) / TOSHIBA eSxxxxSeries (For UK)
* “xxxx” is the model name of the TOSHIBA MFP.
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In the [Name] box, the name that is entered in the [Address] box is automatically displayed.
The way to select the PPD file differs depending on countries or regions as follows:
- For North America

Even when you enter the IP address or DNS name of this equipment in the [Address] box, the correct 
PPD file is not selected in the [Print Using] box. Therefore, select [Other] in the [Print Using] box, and 
select the PPD file (TOSHIBA_eSxxxxSeries USA) from the [/Library/Printers/PPDs/Contents/
Resources/en.lproj] folder.

- For UK
When you enter the IP address or DNS name of this equipment in the [Address] box, the correct PPD 
file is automatically selected in the [Print Using] box. If the correct PPD is not automatically selected, 
select [Select a driver to use] and select the PPD file displayed in the list.

* “xxxx” is the model name of the TOSHIBA MFP.

4 Click [Add].
The Installable Options window appears.

5 Select the options depending on your environment.

Configure options depending on your equipment.
 P.75 “Options”

6 Click [Continue].
The printer is added to the Printer List.
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Configuring Bonjour printing (Mac OS X 10.5.x)

1 Open System Preferences and click [Print & Fax].

2 Click [+].
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3 Click [Default] and select the TOSHIBA MFP of the Bonjour connection displayed in the 
list.

In the [Name] box, the device name that you selected in the list is automatically displayed.
The way to select the PPD file differs depending on countries or regions as follows:
- For North America

Even when you select the equipment from the list, the correct PPD file is not selected in the [Print Using] 
box. Therefore, select [Other] in the [Print Using] box, and select the PPD file (TOSHIBA_eSxxxxSeries 
USA) from the [/Library/Printers/PPDs/Contents/Resources/en.lproj] folder.

- For UK
When you select the equipment from the list, the correct PPD file is automatically selected in the [Print 
Using] box. If the correct PPD is not automatically selected, select [Select a driver to use] and select the 
PPD file displayed in the list.

* “xxxx” is the model name of the TOSHIBA MFP.

4 Click [Add].
The [Installable Options] window appears.

5 Select the options depending on your environment.

Configure options depending on your equipment.
 P.75 “Options”

6 Click [Continue].
The printer is added to the Printer List.
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Configuring the printer on Mac OS X 10.4.x
After you copy the PPD file to the library folder in the System Folder, you can configure the printer.
This equipment supports the following Macintosh Printing Services: LPR Printing, IPP Printing, and Bonjour Printing.

LPR printing
When this equipment and your computer are connected over TCP/IP network, you can perform LPR printing from 
Macintosh computer.
IPP printing
When this equipment and your computer are connected over TCP/IP network, you can perform IPP printing from 
Macintosh computer.
Bonjour printing
When this equipment and your computer are connected over TCP/IP network, you can perform Bonjour printing from 
Macintosh computer.

Configuring LPR printing (Mac OS X 10.4.x)

1 Start the Printer Setup Utility located in the “Applications:Utilities” folder in the Boot 
Disk.

The [Printer List] dialog box appears.

2 Click [Add].
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3 Click [IP Printer] and specify the items as described below.

Protocol: Line Printer Daemon - LPD
Address: <IP address or DNS name of this equipment>
Queue: print
Name: <Any Name>
Location: <Any Name>
Print Using:  TOSHIBA eSxxxxSeries USA (For North America) / TOSHIBA eSxxxxSeries (For UK)
* “xxxx” is the model name of the TOSHIBA MFP.

In the [Name] box, the name that is entered in the [Address] box is automatically displayed.
When you enter the IP address or DNS name of this equipment in the [Address] box, the correct PPD file is 
automatically selected in the [Print Using] box. If the correct PPD is not automatically selected, select 
[TOSHIBA] in the [Print Using] box and select the PPD file displayed in the list.

4 Click [Add].
The [Installable Options] window appears.

5 Select the options depending on your environment.

Configure options depending on your equipment.
 P.75 “Options”

6 Click [Continue].
The printer is added to the Printer List.



3 INSTALLING PRINTER DRIVERS FOR MACINTOSH

92    Installing the Printer on Mac OS X 10.2.4 to Mac OS X 10.6.x

Configuring IPP printing (Mac OS X 10.4.x)
When you want to setup IPP print queue in the Mac OS X, follow the procedures below.

1 Start the Printer Setup Utility located in the “Applications:Utilities” folder in the Boot 
Disk.

The [Printer List] dialog box appears.

2 Click [Add].

3 Click [IP Printer] and specify the items as described below.

Protocol: Internet Printing Protocol - IPP
Address: <IP address or DNS name of this equipment>
Queue: Print
Name: <Any Name>
Location: <Any Name>
Print Using:  TOSHIBA eSxxxxSeries USA (For North America) / TOSHIBA eSxxxxSeries (For UK)
* “xxxx” is the model name of the TOSHIBA MFP.

In the [Name] box, the name that is entered in the [Address] box is automatically displayed.
When you enter the IP address or DNS name of this equipment in the [Address] box, the correct PPD file is 
automatically selected in the [Print Using] box. If the correct PPD is not automatically selected, select 
[TOSHIBA] in the [Print Using] box and select the PPD file displayed in the list.
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If you delete a self-signed certificate registered to this equipment while SSL for HTTP network service is 
enabled, access to the TopAccess is refused. In this case, temporarily disable SSL for HTTP network 
service on the control panel and then access the TopAccess. Then enable SSL again.
For HTTP network service, refer to the TopAccess Guide. For instructions on how to set it on the control 
panel, refer to the MFP Management Guide.
When IPP/SSL is enabled, click [More Printers] while pressing the [option] key. In the displayed dialog box, 
select “Advanced” in the drop down menu and specify as follows:

- Device: Internet Printing Protocol using HTTP
- Device Name: <Any Name>
- Device URI: http://<IP address>:443/Print
- Printer Model: TOSHIBA
- PPD: TOSHIBA eSxxxxSeries USA (For North America) / TOSHIBA eSxxxxSeries (For UK)

* “xxxx” is the model name of the TOSHIBA MFP.

4 Click [Add].
The [Installable Options] window appears.

5 Select the options depending on your environment.

Configure options depending on your equipment.
 P.75 “Options”

6 Click [Continue].
The printer is added to the Printer List.
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Configuring Bonjour printing (Mac OS X 10.4.x)

1 Start the Printer Setup Utility located in the “Applications:Utilities” folder in the Boot 
Disk.

The [Printer List] dialog box appears.

2 Click [Add].

3 Click [Default Browser] and select the equipment of the Bonjour connection displayed 
in the list.

In the [Name] box, the device name that you selected in the list is automatically displayed.
When you select the equipment in the list, the correct PPD file is automatically selected in the [Print Using] 
box. If the correct PPD is not automatically selected, select [TOSHIBA] in the “Print Using” drop down menu 
and select the PPD file displayed in the list.

4 Click [Add].
The [Installable Options] window appears.
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5 Select the options depending on your environment.

Configure options depending on your equipment.
 P.75 “Options”

6 Click [Continue].
The printer is added to the Printer List.
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Configuring the printer on Mac OS X 10.2.4 to 10.3.x
After you copy the PPD file to the library folder in the System Folder, you can configure the printer.
This equipment supports the following Macintosh Printing Services: LPR Printing, AppleTalk Printing, IPP Printing, and 
Bonjour Printing.

LPR printing
When this equipment and your computer are connected over TCP/IP network, you can perform LPR printing from 
Macintosh computer.
AppleTalk printing
When this equipment and your computer are connected over AppleTalk network, you can perform AppleTalk printing 
from Macintosh computer.
IPP printing
When this equipment and your computer are connected over TCP/IP network, you can perform IPP printing from 
Macintosh computer.
Bonjour printing
When this equipment and your computer are connected over TCP/IP network, you can perform Bonjour printing from 
Macintosh computer.

Configuring LPR printing (Mac OS X 10.2.4 to 10.3.x)
The following describes an operation on Mac OS X 10.3.x. The procedure is the same when Mac OS X 10.2.4 to 10.2.8 is 
used.

1 Start the Print Center (for Mac OS X 10.2.4 to 10.2.8) or Printer Setup Utility (for Mac OS 
X 10.3.x) located in the “Applications:Utilities” folder in the Boot Disk.
Mac OS X 10.2.4 to 10.2.8

Mac OS X 10.3.x

The [Printer List] dialog box appears.

2 Click [Add].
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3 Select [IP Printing] in the drop down list box and specify the items as described below.

Printer Type: LPD/LPR
Printer’s Address: <IP address or DNS name of this equipment>
Queue Name: print
Printer Model: TOSHIBA
PPD: TOSHIBA e-STxxxx Series (or UK)
* “xxxx” is the model name of the TOSHIBA MFP.

For Mac OS X 10.2.4 to 10.2.8, the [Printer Type] drop down list box is not displayed.
For Mac OS X 10.2.4 to 10.2.8, please uncheck the [Use default queue on server] box.

4 Click [Add].
The printer is added to the Printer List.

5 Continue the procedure to configure the installable options.
 P.103 “Configuring the installable options”
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Configuring AppleTalk printing (Mac OS X 10.2.4 to 10.3.x)
The following describes an operation on Mac OS X 10.3.x. The procedure is the same when Mac OS X 10.2.4 to 10.2.8 is 
used.

1 Start the Print Center (for Mac OS X 10.2.4 to 10.2.8) or Printer Setup Utility (for Mac OS 
X 10.3.x) located in the “Applications:Utilities” folder in the Boot Disk.
Mac OS X 10.2.4 to 10.2.8

Mac OS X 10.3.x

The [Printer List] dialog box appears.

2 Click [Add].

3 Select [AppleTalk] in the drop down list box and select the zone name that this 
equipment is located. Then select the equipment displayed in the list.

If the AppleTalk network is not configured with a zone, select [Local AppleTalk zone].
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4 Select [TOSHIBA] at the [Printer Model] box, and select the PPD file.

5 Click [Add].
The printer is added to the Printer List.

6 Continue the procedure to configure the installable options.
 P.103 “Configuring the installable options”
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Configuring IPP printing (Mac OS X 10.2.4 to 10.3.x)
When you want to setup IPP print queue in the Mac OS X, follow the procedures below.
The following describes an operation on Mac OS X 10.3.x. The procedure is the same when Mac OS X 10.2.4 to 10.2.8 is 
used.

1 Start the Print Center (for Mac OS X 10.2.4 to 10.2.8) or Printer Setup Utility (for Mac OS 
X 10.3.x) located in the “Applications:Utilities” folder in the Boot Disk.
Mac OS X 10.2.4 to 10.2.8

Mac OS X 10.3.x

The [Printer List] dialog box appears.

2 Press and hold the [option] key in the keyboard and click [Add] in the Printer List 
Window.

The print list is displayed with all the print options.
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3 Select [Advanced] in the drop down list box and specify the items as described below.

Device: Mac OS X 10.2.x: Internet Printing Protocol (http)
Mac OS X 10.3.x: Internet Printing Protocol using HTTP

Device Name: <Any Name>
Device URI: http://<IP address>:631/Print
Printer Model: TOSHIBA
PPD: TOSHIBA e-STxxxx Series (or UK)
* “xxxx” is the model name of the TOSHIBA MFP.

If you delete a self-signed certificate registered to this equipment while SSL for HTTP network service is 
enabled, access to the TopAccess is refused. In this case, temporarily disable SSL for HTTP network 
service on the control panel and then access the TopAccess. Then enable SSL again. 
For HTTP network service, refer to the TopAccess Guide. For instructions on how to set it on the control 
panel, refer to the MFP Management Guide.
When IPP/SSL is enabled, specify as follows:
- Device: Internet Printing Protocol (http)
- Device URI: http://<IP address>:443/Print

4 Click [Add].
The printer is added to the Printer List.

5 Continue the procedure to configure the installable options.
 P.103 “Configuring the installable options”
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Configuring Bonjour printing (Mac OS X 10.2.4 to 10.3.x)
The following describes an operation on Mac OS X 10.3.x. The procedure is the same when Mac OS X 10.2.4 to 10.2.8 is 
used.

1 Start the Print Center (for Mac OS X 10.2.4 to 10.2.8) or Printer Setup Utility (for Mac OS 
X 10.3.x) located in the “Applications:Utilities” folder in the Boot Disk.
Mac OS X 10.2.4 to 10.2.8

Mac OS X 10.3.x

The [Printer List] dialog box appears.

2 Click [Add].

This is mandatory to show all the advanced print options in the drop down list box in the [Printer List] window.
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3 Select [Rendezvous] in the drop down list box and select the equipment displayed in 
the list.

When you select the equipment in the name list, the correct PPD file is automatically selected. If the correct 
PPD is not automatically selected, select [TOSHIBA] in the “Printer Model” drop down menu and select the 
PPD file displayed in the list.

In Mac OS X 10.2.4 to 10.3.x, the [Bonjour] is named as [Rendezvous].

4 Click [Add].
The printer is added to the Printer List.

5 Continue the procedure to configure the installable options.
 P.103 “Configuring the installable options”

Configuring the installable options
The following describes an operation on Mac OS X 10.3.x. The procedure is the same when Mac OS X 10.2.4 to 10.2.8 is 
used.

1 In the [Printer List] dialog box, select the printer and then select [Show Info] in the 
[Printers] menu.

The [Printer Info] dialog box appears.

2 Select [Installable Options] in the drop down list box.

The [Installable Options] window is displayed.
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3 Select the options depending on your environment.

Configure options depending on your equipment.
 P.75 “Options”

4 Click [Apply Changes] and close the window.
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Uninstalling the Macintosh PPD File

In order to uninstall the Macintosh PPD file, delete the PPD file in the following folder.

For Mac OS X 10.2.4 to 10.3.x for North America
Library/Printers/PPDs/Contents/Resources/en.lproj/TOSHIBA_e-STxxxxSrs.gz
Library/Printers/Toshiba/filter
Library/Printers/Toshiba/Icons
Library/Printers/Toshiba/PDEs
Library/Receipts

For Mac OS X 10.2.4 to 10.3.x for UK
Library/Printers/PPDs/Contents/Resources/en.lproj/TOSHIBA_e-STxxxxSrsUK.gz
Library/Printers/Toshiba/filter
Library/Printers/Toshiba/Icons
Library/Printers/Toshiba/PDEs
Library/Receipts

For Mac OS X 10.4.x to 10.6.x for North America
Library/Printers/PPDs/Contents/Resources/en.lproj/TOSHIBA_eSxxxxSeriesUSA.gz
Library/Printers/Toshiba/filter
Library/Printers/Toshiba/Icons
Library/Printers/Toshiba/PDEs
Library/Receipts

For Mac OS X 10.4.x to 10.6.x for UK
Library/Printers/PPDs/Contents/Resources/TOSHIBA_eSxxxxSeries.gz
Library/Printers/Toshiba/filter
Library/Printers/Toshiba/Icons
Library/Printers/Toshiba/PDEs
Library/Receipts
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Before Installation

This section describes about the installation of the scan driver and utilities. Before installing them, read this section.

Type of scan driver and utilities
Install the following utilities to use the network scan functions.

TWAIN driver
This software component enables you to import e-Filing documents into TWAIN-compliant applications.

File Downloader
This software component enables you to import e-Filing documents into your hard disk.

Remote Scan driver
You can use Remote Scan driver to import the scanned images into your TWAIN-compliant application.

WIA driver
You can use Remote Scan driver to import the scanned images into your WIA-compliant application.

System requirements
The scan driver and utilities are available for following environments:

Display resolution
1024 x 768 dots or more
Display color
High Color (16 bit) or higher is recommended
CPU
Pentium 133 MHz minimum (Pentium 266 MHz or faster recommended)
OS
Windows 2000 Service Pack 4
Windows XP Service Pack 2 or later
Windows Vista Service Pack 1 or later
Windows 7
Windows Server 2003 Service Pack 2
Windows Server 2008 Service Pack 1 or later

WIA driver is not supported by Windows 2000 and 64-bit edition of each Windows XP and Windows Server 2003.

When scan driver and utilities have been installed
If the scan driver and utilities have been installed from other e-STUDIO Client Utilities CD-ROM, uninstall them then install 
again from the Client Utilities CD-ROM.
When you uninstall the software, click [No] at the dialog box that displays the message to delete the settings for the scan 
driver and utilities so that you can restore the settings after installing new one.

To use scan drivers, the scanning function is required. 
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Installing Scan Driver and Utilities

This section describes how to install the scan driver and utilities.

Installing the scan driver and utilities using the installer

To perform installation, you must log onto Windows with a user account, which enables the installation and 
uninstallation of client software, such as “Administrators” or “Power Users”.
If Windows 7 is used, you can perform the installation by temporarily changing the user account following the 
procedure below.
- Open the “e-STUDIO” folder in a CD-ROM, and then double-click “Setup.exe”.
- When the [User Account Control] dialog box is displayed, enter the password of “Administrators”, and then click 

[OK] ([Yes]).

1 Insert the Client Utilities CD-ROM into the CD-ROM drive.
If the installer does not automatically start, use the Explorer to open the “e-STUDIO” folder in the Client Utilities 
CD-ROM and double-click “Setup.exe”.

2 Select [I agree to the terms of the License Agreement.] and click [Next].

To change the display language, select a desired language from the [Select Language] box.
The main menu is displayed.

3 Click [Scan Utility].
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4 Confirm the list of the software to install and click [Install].

You can change the folder where these programs are installed. Click [Browse] and, when the [Browse For 
Folder] dialog box appears, select a folder and click [OK].
The installation starts.

5 When the installation is complete, click [Finish].

The main menu is displayed.

The Installer may ask you to restart your computer. If it does, select “Yes, I want to restart my computer now.” 
and click [Finish] to restart your computer.

6 Click [Exit].
When a message appears asking whether to finish the installation, click [Yes].
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Uninstalling Scan Driver and Utilities

You can uninstall scan driver and utilities using Uninstall a program function in Control Panel. For instructions on how to 
uninstall them, refer to the following section.

 P.126 “Uninstalling Client Software”
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Before Installation

This section describes about the installation of the network fax utilities. Before installing them, read this section.

Type of network fax utilities
Install the following utilities to use the network fax functions.

N/W-Fax driver
The N/W-Fax driver enables you to set up send lists and send electronic documents from your client computer to one or 
more destinations. You print to the fax much the same way you would choose to print to a designated printer that makes 
using the N/W-Fax driver quick and simple. You can select the fax properties. Fax properties are the attributes you can set 
to define sender and recipient information for processing fax jobs such as dialing options, sender information, fax 
resolution and page layout.
Other features include an easy to use fax scheduler that allows you to set up a date and time to transmit your fax. Cover 
page options are also provided. You can include a customized cover page with your fax transmission that can include 
sender and recipient fax information and a detailed message. You can easily maintain sender and contact information that 
can be printed on the cover pages.

AddressBook Viewer
With the AddressBook Viewer you can easily add or modify fax recipient names, fax numbers, and Email address (Email 
address) to the Address Book. This utility allows you to manage recipients of the fax, select and display fax recipients from 
the Address Book, as well as recipient fax numbers and other contact information.
Additionally, AddressBook Viewer allows you to import or export address book data to or from other address book 
programs compatible to this equipment.

System requirements
The N/W-Fax driver and AddressBook Viewer are available for following environments:

Display resolution
1024 x 768 dots or more
Display color
High Color (16 bit) or higher is recommended
CPU
Pentium 133 MHz minimum (Pentium 266 MHz or faster recommended)
Memory
The required memory size for OS
OS
Windows 2000 Service Pack 4
Windows XP Service Pack 2 or later
Windows Vista Service Pack 1 or later
Windows 7
Windows Server 2003 Service Pack 2
Windows Server 2008 Service Pack 1 or later

When network fax utilities and AddressBook Viewer have been installed
If the N/W-Fax driver and AddressBook Viewer have been installed from other e-STUDIO Client Utilities CD-ROM, 
uninstall them then install again from the Client Utilities CD-ROM.
When you uninstall the AddressBook Viewer, click [No] at the dialog box that displays the message to delete the settings 
for the AddressBook Viewer so that you can restore the settings after installing new one.
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Installing Network Fax Utilities

This section describes how to install the network fax utilities in an SMB environment which is available for a local area 
network using TCP/IP.

Before installing the printer driver in an SMB environment, confirm the following:
- This equipment is connected to the network and turned on.
- The TCP/IP setting is correct on this equipment and your computer.

To perform installation, you must log onto Windows with a user account, which enables the installation and 
uninstallation of client software, such as “Administrators” or “Power Users”.
If Windows 7 is used, you can perform the installation by temporarily changing the user account following the 
procedure below.
- Open the “e-STUDIO” folder in a CD-ROM, and then double-click “Setup.exe”.
- When the [User Account Control] dialog box is displayed, enter the password of “Administrators”, and then click 

[OK] ([Yes]).

1 Insert the Client Utilities CD-ROM into the CD-ROM drive.
If the installer does not automatically start, use the Explorer to open the e-STUDIO folder in the Client Utilities 
CD-ROM and double-click “Setup.exe”.

2 Select [I agree to the terms of the License Agreement.] and click [Next].

To change the display language, select a desired language from the [Select Language] box.
The main menu is displayed.

3 Click [Fax Driver].
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4 Confirm the list of the software to install and click [Install].

You can change the folder where these programs are installed. Click [Browse] and, when the [Browse For Folder] 
dialog box appears, select a folder and click [OK].

Click [SNMP Settings] if a community name other than "public" (default) is set for the SNMP community name 
for your TOSHIBA MFP.
When the [SNMP Settings] dialog box appears, change the SNMP community name and click [OK].
When you change the SNMP community name, see the following page:

 P.11 “Precautions for changing SNMP Community Name”

Since the subsequent procedure is the same as that for printer driver installation, the steps are omitted. See the following 
pages according to the connection environment.

 P.32 “Installing the Printer Drivers for Raw TCP/LPR Printing”
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Installing Web Service Print

You can install a N/W-Fax driver in Windows 7 using the WSD (Web Services on Devices) protocol. Since the installation 
procedure is the same as that for printer driver installation, it is omitted. When performing installation, see the following 
page:

 P.56 “Web Service Print”
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Uninstalling the Network Fax Software

The following instructions describe how to uninstall the N/W-Fax driver and AddressBook Viewer.

Uninstalling N/W-Fax driver
You can uninstall a N/W-Fax driver. Since the uninstallation procedure is the same as that for printer driver uninstallation, 
it is omitted. When performing uninstallation, see the following page:

 P.61 “Uninstalling Printer Drivers”

Uninstalling AddressBook Viewer
You can uninstall AddressBook Viewer using Uninstall a program function in Control Panel. For instructions on how to 
uninstall them, refer to the following section.

 P.126 “Uninstalling Client Software”
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Before Installation

This section describes about the installation of the e-Filing Backup/Restore utilities. Before installing them, read this 
section.

System requirements
The e-Filing Backup/Restore Utility is available for following environments:

Display resolution
1024 x 768 dots or more
Display color
High Color (16 bit) or higher is recommended
CPU
Pentium 133 MHz minimum (Pentium 266 MHz or faster recommended)
Memory
The required memory size for OS
OS
Windows 2000 Service Pack 4
Windows XP Service Pack 2 or later
Windows Vista Service Pack 1 or later
Windows 7
Windows Server 2003 Service Pack 2
Windows Server 2008 Service Pack 1 or later
Required software
Microsoft Internet Explorer 5.5 Service Pack 2 or later (Internet Explorer 7.0 or later when IPv6 is used)
Microsoft Internet Explorer is enabled to access the e-Filing web utility on this equipment.
- The proxy settings must be configured correctly to enable the access.
- The browser must not be offline.

To backup/restore e-Filing data using e-Filing Backup/Restore utility, the FTP server option that can be set in the 
network settings of TopAccess must be enabled.
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Installing e-Filing Backup/Restore Utilities

This section describes how to install the e-Filing Backup/Restore utilities.

To perform installation, you must log onto Windows with a user account, which enables the installation and 
uninstallation of client software, such as “Administrators” or “Power Users”.
If Windows 7 is used, you can perform the installation by temporarily changing the user account following the 
procedure below.
- Open the “e-STUDIO” folder in a CD-ROM, and then double-click “Setup.exe”.
- When the [User Account Control] dialog box is displayed, enter the password of “Administrators”, and then click 

[OK] ([Yes]).

1 Insert the Client Utilities CD-ROM into the CD-ROM drive.
When inserting the Client Utilities CD-ROM, the installer may automatically start. Click [Exit] to exit the installer and 
continue the operation.

2 Open “Admin\e-FilingUtility” folder and double-click “setup.exe”.

The [Choose Setup Language] dialog box appears.

3 Select your language and click [OK].

The [InstallShield Wizard] dialog box appears.

4 Click [Next].

The [License Agreement] dialog box appears.
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5 Select “I accept the terms in the license agreement” and click [Next].

The [Destination Folder] dialog box appears.

6 Click [Next].

If you want to change where the programs are installed, click [Change]. In the dialog box appears, select the 
folder and click [OK].
[Ready to Install Program] dialog box appears.

7 Click [Install].

Starts copying files and the InstallShield Wizard Completed screen displayed when copying is completed.
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8 Click [Finish].

The installation is completed.

The Installer may ask you to restart your computer. If it does, select “Yes”, I want to restart my computer now.” 
and click [Finish] to restart your computer.
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Uninstalling e-Filing Backup/Restore Utilities

You can uninstall e-Filing Backup/Restore utilities using Uninstall a program function in Control Panel. For instructions on 
how to uninstall them, refer to the following section.

 P.126 “Uninstalling Client Software”
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Uninstalling Client Software

The following describes how to uninstall client software.

The printer drivers and N/W-Fax driver cannot be uninstalled by the setup program. For instructions on how to uninstall 
them, refer to the following section.

 P.61 “Uninstalling Printer Drivers”

1 Click [Start] and then [Control Panel]. Open [Control Panel] and select [Uninstall a 
program].

The Uninstall or change a program dialog box appears.

2 From the list, select the software you want to remove and click [Uninstall].

3 Click [Yes].

When the [User Account Control] dialog box is displayed, click [Continue] to continue the installation. However, 
if you have logged on with a user account other than “Administrators”, enter the password of “Administrators” 
and then click [OK] ([Yes]).
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4 Click [Yes] to delete the setting files.

Deleting files starts.

If you want to re-install the client software later, click [No] to remain the setting files. You can restore the data 
and settings when you re-install the client software.
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Repairing Client Software

When the client software will not work correctly, you can repair the client software.

The printer drivers and N/W-Fax driver cannot be repaired by the setup program. To repair them, uninstall them and 
install again.

1 Insert the Client Utilities CD-ROM into the CD-ROM drive.
When inserting the Client Utilities CD-ROM, the Auto Play menu appears. Click [Open folder to view files] to 
open the software folder.

2 Open the software folder that you want to repair and double click the [setup.exe] icon.
To repair TWAIN Driver, locate 
“[Client Utilities CD-ROM]:\Client\TWAIN”.
To repair File Downloader, locate 
“[Client Utilities CD-ROM]:\Client\FD”.
To repair Remote Scan Diver, locate 
“[Client Utilities CD-ROM]:\Client\RS”.
To repair AddressBook Viewer, locate
“[Client Utilities CD-ROM]:\Client\ADRBK\32”.
To repair AddressBook Viewer (for Windows 64-bit edition OSs), locate
“[Client Utilities CD-ROM]:\Client\ADRBK\64”.

When the [User Account Control] dialog box is displayed, click [Continue] to continue the installation. However, 
if you have logged on with a user account other than “Administrators”, enter the password of “Administrators” 
and then click [OK].

3 Select the language and click [OK].

4 Click [Next].
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5 Select [Repair] and click [Next].

6 Click [Install].

Repairing files starts.

7 Click [Finish] to close the wizard.

8 The installer ask you to restart your computer. Click [Yes] to restart your computer. 
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Before Using the Printer Driver

Before printing, you have to configure the following option:
Configuration Settings
To use optional devices such as optional drawers, Finisher or Hole Punch Unit, you must first configure these devices. 
The features of these optional devices are not available unless you tell the system that the optional devices are 
installed.

Before printing, you can configure the following option if necessary:
Department Code
You can use department codes to manage each job. For example, a system administrator can check how many sheets 
of copies a certain department has made. When the Department code is enabled, you are prompted to enter a 
department code before printing. If you enter the department code in the corresponding field in advance, you can print 
without having to do this every time. Ask your administrator about the codes. When SNMP communication between 
the equipment and your computer is enabled, you are also prompted to enter the code before printing.

Configuring the options
To use this equipment properly, you need to save the configuration of the options installed on the [Configuration] tab menu 
after you install the printer drivers. In the default setting, you can obtain the configuration data of options installed 
automatically by opening the [Configuration] tab menu. If SNMP communication between this equipment and your 
computer is not available, or you want to configure options manually, see the following page:

 P.133 “Configuring options manually”

If available, select [Manual] of [Enable SNMP Communication] check box on the [Configuration] tab menu, and then 
click [Update Now]. You can obtain the configuration data as you click it. 
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Configuring options manually
If SNMP communication between this equipment and your computer is not available, configure the options manually.

Setting the [Configuration] tab manually

You need to log into Windows with the “Administrator” or “Power Users” privilege.

1 Click [Start] and select [Devices and Printers].

2 Right-click on the printer driver icon in the Devices and Printers folder, and then select 
[Printer properties] from the menu.

For Windows 7, some tab menus have a  button in the printer driver properties. To change the properties, 
click on it. If the properties cannot be changed, ask your system administrator.
To change a network-installed printer driver, the administrator privilege is necessary. Ask your system 
administrator for details.

3 Select the [Configuration] tab and configure the options depending on your equipment.
Screens of e-STUDIO451c Series are used here.

Options and names may vary depending on the equipment.
For details, refer to the following section.

 “Printing Guide” - “PRINTING FROM WINDOWS” - “Setting Up Print Options”

The Large Capacity Feeder (optional) is not available for some countries or regions.
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4 Click [Drawer Settings].
The [Drawer Settings] dialog box appears.

5 Set the following options and click [OK].

Options and names may vary depending on the equipment.
For details, refer to the following section.

 “Printing Guide” - “PRINTING FROM WINDOWS” - “Setting Up Print Options”

The Large Capacity Feeder (optional) is not available for some countries or regions.

6 Click [Apply] and [OK] to save settings.
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Setting the department code
When this equipment is managed with department codes, you have to enter your department code on the printer driver.
This feature allows a network administrator to check the number of copies printed by a specific department. Also users 
can check who submitted the print jobs, by touch panel display and monitoring tools.
Ask your administrator whether you should enter the Department Code.

When the User Management Setting is enabled on the equipment, the User Management Setting is used to manage 
the print jobs instead of the department code. In that case, the user name that is entered to log in to your computer is 
used for the authentication of the print job. Therefore, you do not need to enter the department code in the printer 
driver but your user name must be registered in the equipment. If the user name is not registered, your print job is 
processed as an invalid job according to the Department Code Enforcement settings.

How the equipment performs printing for an invalid department code print job, for which an invalid department code 
is specified, varies depending on the Department Code Enforcement setting that can be set in the TopAccess 
Administrator mode and whether SNMP communication is enabled or not. When SNMP communication is enabled 
and Department Code Enforcement is set to [ON], an error message will be displayed when entering an invalid 
department code. When SNMP communication is disabled and Department Code Enforcement is set to [ON], the 
invalid department code print job will be stored in the invalid department code print job list without printing. When 
the Department Code Enforcement is set to [Print], the invalid department code print job will be printed. When the 
Department Code Enforcement is set to [Delete], the invalid department code print job will be deleted without 
printing.
A department code needs to be entered every time you begin printing. If you have to use a different department 
code for each print job, enter it when you begin printing.
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Entering department code

1 Click [Start] and select [Devices and Printers].

2 Right-click on the printer driver icon in the Devices and Printers folder, and then select 
[Printing preferences] from the menu.

The printing preferences dialog box appears.

3 Select the [Others] tab menu and enter your department code in the [Department] box.
Screens of e-STUDIO451c Series are used here.

In the [Department] box, only numeric characters can be entered. The Department Code must be a 5-digit number. 
If the department code is shorter than 5 digits, add 0 to make it 5 digits long.

4 Click [Apply] and [OK] to save the settings.
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Copying the PPD file for Windows
The Client Utilities CD-ROM contains a printer description file for popular Windows applications. For applications not 
allowing the automatic installation of PPD files, copy the PPD file to a proper directory in order to enable printer-specific 
settings in the [Print] dialog box or the [Page Setup] dialog box.

Copying the printer description file

1 In the Client Utilities CD-ROM, open the folder that contains the PS3 printer driver.
For Windows 7:
[Client Utilities CD-ROM]:\Client\Drivers\PS\W2K_XP_VISTA\<language>\

2 Copy the printer description file (*.ppd) to the appropriate location.

For a proper directory to which the PPD file is to be copied, refer to the manual of the application.
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Printing from an Application

This section describes how to print a document from an application.
 P.138 “Considerations and limitations”
 P.139 “How to print”

Considerations and limitations
When the User Management Setting is enabled on the equipment, the user name that is entered to log in to your 
computer is used for the authentication of the print job. Therefore, your user name must be registered in the 
equipment. If the user name is not registered, your print job is processed as an invalid job according to the Department 
Code Enforcement settings.
When the Windows Domain Authentication is used for the User Management Setting, your computer must log into the 
domain.
Some print options can be set from both the application and the printer driver, such as collation. If the collation is set 
from the application, documents may not be properly printed. If that happens, use the printer driver to set the collation. 
Depending on the application, some print options such as the orientation need to be set from the application. For print 
options that can be set from both the application and the driver, refer to the manual of the application.

About “Use PostScript Passthrough”
When printing with the PS3 printer driver from Adobe Acrobat, the Fit to Paper enlargement feature does not work if 
the [Use PostScript Passthrough] option is enabled in the PostScript settings of the PS3 printer driver. To use the Fit to 
Paper enlargement feature, disable the [Use PostScript Passthrough] option in the PostScript settings of the PS3 
printer driver.
When printing with the PS3 printer driver from an application that creates the PostScript code for printing such as 
Adobe Acrobat, the following print options may not work correctly. In that case, disable the [Use PostScript 
Passthrough] option in the PostScript settings of the PS3 printer driver.
- Manual Scale
- Print Paper Size
- Paper Type
- Use Front Cover
- Use Back Cover
- Interleave Pages
- Insert Pages
- Booklet
- Multiple Pages per Sheet
- All options in the [Effect] tab
- All options in the [Image Quality] tab
- Margin
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How to print
Once you have installed the printer driver and configured it properly, you can print directly from most Windows 
applications. Simply choose the Print command from your application.
You can print using the various functions by setting print options on the printer driver.

Printing from Windows applications

The following describes an example for printing from Notepad on Windows Vista.

1 Open a file and select [Print] from the menu button of the applications.
The [Print] dialog box appears.

2 Select the printer driver of the equipment to be used and click [Preferences].
Screens of e-STUDIO451c Series are used here.

The [Printing Preferences] dialog box appears.

The procedures for displaying the properties dialog for the printer driver may be different depending on the 
application that you are using. See your application’s manual about displaying the printer properties dialog box.

3 Set the print options on each tab according to how you want to print.
Screens of e-STUDIO451c Series are used here.

Setting the print options varies depending on how you want to print a document.
 P.145 “Print options”

You can also set the print options using profiles.
 P.142 “Setting print options using profiles”

4 Click [OK] to save the settings.
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5 Click [Print] to print a document.
Screens of e-STUDIO451c Series are used here.
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Setting Up Print Options

Print Options are the attributes you set to define the way a print job is processed. For example, the private print and proof 
print options determine how the copier manages your print job.

To find the printing instructions for your specific needs, see the procedures in the following section.
 “Printing Guide” - “PRINTING FROM WINDOWS” - “Printing with the Best Functions for Your Needs”

How to set up
There are several ways to set print options. How the settings affect printing varies depending on the way you set the 
options. The tabs displayed also vary depending on how you display the printer properties.

Setting initial values of print options
Setting the print options by displaying the printer properties from the Printers folder within the Windows Start menu will 
establish the initial values of the options. For example, the paper size setting you most commonly use, optional device 
settings, user information settings, etc., are settings you will not want to change every time you print. It is convenient to set 
these options as initial values.

How to display:

1 Click [Start] and select [Devices and Printers].

2 Select the printer driver of your equipment, click the [File] menu and select [Printing 
Preferences].
If the [File] menu is not displayed, press [Alt].

Setting print options for each print job
The print options that are set in properties dialog box, which can be accessed from the [Print] dialog box of the application, 
are only applied to the current print job, so once you close it, the options will be invalid.

How to display:

1 Click the [File] menu and select [Print] in the application.

2 Select the printer driver of the equipment to be used and click [Properties].
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Setting print options using profiles
Using profiles, you can save the print settings or apply the saved settings to a print job.

There are 4 factory default profiles as follows:
- Duplex, Staple & 2in1
- Booklet
- Duplex & Staple
- Duplex, Staple & Punch

In order to print a document using profiles, you must first create the saved profile.
 P.142 “Saving profiles”

Once you save a profile, you can apply its settings to a print job.
 P.143 “Loading profile”

You can also delete unnecessary profiles.
 P.144 “Deleting profile”

Saving profiles

You can register up to 20 profiles (including 4 default profiles) for each printer driver.

You can delete the default profile or overwrite it after changing its contents and saving it under the same name.

1 Configure the print options on each tab.
Setting the print options varies depending on how you want to print a document.

 P.145 “Print options”

2 Click [Save Profile] in the Profile group.
Screens of e-STUDIO451c Series are used here.

The [Profile Name] dialog box appears.
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3 Enter the profile name and click [OK].

The file name can be up to 63 characters long.

If you enter the existing profile name, you are prompted to confirm whether you want to overwrite it. If you 
want to, click [OK].
If you try to save more than 20 profiles, a dialog box notifying you that no more profiles can be saved 
appears, and then the 21st profile is saved as a temporary profile. If you want to register this temporary 
profile, delete unnecessary profiles first, and then select [Temporary Profile] to recall this profile and click 
[Save Profile] to save it.
You cannot specify [None] for the profile name.

4 The profile is saved.

Loading profile

1 Select a profile in the [Profile] box.
Screens of e-STUDIO451c Series are used here.

The setting options in the profile are reflected on each tab.

To restore the default settings after you select the profile, click [Restore Defaults] on each tab. Selecting [None] 
on the [Profile] box will not restore them. To restore the default settings on any tab other than the [Fonts] and 
[Configuration] tabs, click [Restore All Defaults] on the [Others] tab.
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Deleting profile

1 Select the profile that you want to delete in the [Profile] box, and click [Delete].
Screens of e-STUDIO451c Series are used here.

The [Confirm Delete] dialog box appears.

2 Click [Yes] to delete the selected profile.
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Print options
This section describes print options in each tab of the printer driver. This section will help you to find the description of 
specific print options, or understand the functions of each print option.

How to display:

1 Click [Start] and select [Devices and Printers].

2 Right-click on the printer driver icon in the Devices and Printers folder, and then select 
[Printer properties] from the menu.
The printing preferences dialog box appears.

Screens of e-STUDIO451c Series are used here. Screens may be different depending on your printer driver.

1) Printer Name
Displays the name given to the printer driver when it was installed, or the name it displays on the icon in the Printer 
folder.

2) Menu Tabs
The menu items of the printer driver are displayed as tabs. Clicking on a tab will display the contents of the selected 
tab. The tabs displayed vary depending on the way the print properties are displayed.
- [Basic] tab

The [Basic] tab contains basic print operation settings, such as original paper size, print paper size, paper source, 
paper type, number of copies, orientation, and so on.

 “Printing Guide” - “PRINTING FROM WINDOWS” - “Setting Up Print Options”- “Print options”- “[Basic] tab”
- [Finishing] tab

The [Finishing] tab allows you to enable sort printing, 2-sided printing, N-up printing, stapling and punching.
 “Printing Guide” - “PRINTING FROM WINDOWS” - “Setting Up Print Options”- “Print options”- “[Finishing] tab”

- [Paper Handling] tab
The [Paper Handling] tab contains Cover page printing.

 “Printing Guide” - “PRINTING FROM WINDOWS” - “Setting Up Print Options”- “Print options”- “[Paper 
Handling] tab”

- [Image Quality] tab
The [Image Quality] tab allows you to select how images are printed. You can easily select appropriate image 
quality depending on the type of job being printed.

 “Printing Guide” - “PRINTING FROM WINDOWS” - “Setting Up Print Options”- “Print options”- “[Image Quality] 
tab”

- [Effect] tab
The [Effect] tab contains print options that add the effects to your print jobs such as Watermarks, Overlay Image 
printing and so on.

 “Printing Guide” - “PRINTING FROM WINDOWS” - “Setting Up Print Options”- “Print options”- “[Effect] tab”

1

2
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7 8 9 10
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- [Others] tab
The [Others] tab contains special features such as toner save, custom pager size, and so on. You can also import 
and export your settings of Watermarks, Overlay, Original Paper Type, Custom Paper Size and Profiles.

 “Printing Guide” - “PRINTING FROM WINDOWS” - “Setting Up Print Options”- “Print options”- “[Others] tab”
- [Fonts] tab

The [Fonts] tab allows you to select how the TrueType fonts are printed. This tab is only displayed when the printer 
properties are accessed from the Printers folder.

 “Printing Guide” - “PRINTING FROM WINDOWS” - “Setting Up Print Options”- “Print options”- “[Fonts] tab”
- [Configuration] tab

The [Configuration] tab allows you to configure the options. When any optional unit is installed in this equipment, 
set the configuration of the machine on this tab. This tab is only displayed when the printer properties are accessed 
from the Printers folder.

 “Printing Guide” - “PRINTING FROM WINDOWS” - “Setting Up Print Options”- “Print options”- “[Configuration] 
tab”

3) Print Job
This option sets the type of print job.
- Normal Print

Select this option to print a job normally.
- Scheduled Print

Select this option to print a job at a specified date and time.
When this option is selected, click the button on the right to set the date and time to print a job.

- Private Print
Select this option to print a private job. When you select this option, enter a password using the alphanumeric 
characters and symbol characters (ASCII code characters between 0x21 to 0x7E) in the [Password] box that is 
displayed after the print settings have been made and the print job is sent. The password must be between 1 and 
63 characters.
The print job, sent as a private job, is saved in the private job queue on this equipment, and is not printed until you 
activate printing from the touch panel display. This option is useful when you want to print a confidential document 
that is secured by a password. The user has to enter the password to print the private job when activating printing 
from the touch panel display.

The private print function can be used when the user management setting is disabled on the equipment.

- Proof Print
Select this option to print the first copy of a multicopy job and then wait for approval before printing the remaining 
copies. If a print job is sent as a proof job, one copy of the job is printed and the remaining copies are saved in the 
proof job queue on this equipment, which are not printed until you activate printing from the touch panel display. 
This option allows you to check a job’s output before printing the remaining copies and thereby reduces paper 
waste.

When you want to print multiple copies, each of which is to be sent as an individual print job by your application, all 
the copies, not just one copy, will be printed even if you set Proof Print. In such a case, print just one trial copy first, 
and then specify the required number of copies on the touch panel display.

- Print to Overlay File
Select this option to save the print job as an overlay file that is imposed on other documents. When you select this 
option, click the button on the right and enter the file name.
For example, if you want to print a master page image on the background of a document, you can create an 
overlay file of the master merge image using this option. Then you can print a document using this overlay by 
specifying this file as an overlay image in the [Overlay Image] option of the [Effect] tab.

If the print job has several pages in the document, only the first page of the document will be saved as an 
overlay file.
Both the overlay file and the documents on which you superimpose the overlay image must be created at the 
same size and orientation.
When creating an overlay file using the PS3 printer driver from an application that can create the PS command 
directly, the overlay file will not be created properly. In that case, disable the [Use PostScript Passthrough] 
option in the [PostScript Settings] dialog box.

 “Printing Guide” - “PRINTING FROM WINDOWS” - “Setting Up Print Options”- “Print options”- “[Others] tab”
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- Store to e-Filing
Select this option to save a job to e-Filing. When this option is selected, select the box after the print setting has 
been finished. When the SNMP communication is enabled, it detects the available box numbers and box name. If 
not, all are listed in the box.
If you select a user box, you may be required to enter the appropriate password for the selected box. The job saved 
to a box can be printed from the touch panel display at a later time. It can also be composed with other documents 
using the e-Filing web utility.
You can also print a job and save it to a box by checking on the [Print] option.

When you store a document in e-Filing using the printer driver, the printing image (not the original document in 
your computer) will be stored in e-Filing.
Documents stored in e-Filing are retained with the best image quality for printing. If you want to download them 
into your computer with a higher image quality, scan the original documents and store them in e-Filing.

For more information about e-Filing operations, refer to the e-Filing Guide.
For the detailed instructions on how to print with the [Print job] setting, see the following page:

 “Printing Guide” - “PRINTING FROM WINDOWS” - “Printing with the Best Functions for Your Needs”- 
“Printing various print job types”

4) Preview window
In the Preview window, you can check the current settings in the printer driver. You can change the view type by 
clicking [Graphics] to display the print options settings graphically or [Text] to display the print option settings in text 
form.

5) Profile
Print option settings can be saved on your hard disk. You can save print option settings by clicking [Save Profile] and 
easily load a setting file by selecting a profile name in the box.

 P.142 “Setting print options using profiles”

There are 4 factory default profiles.

6) [Restore Defaults]
Click this button to restore the settings to the original factory defaults.

7) [OK]
Click this button to enter the input settings and complete the print option settings.

8) [Cancel]
Click this button to cancel the input settings and exit the print option settings.

9) [Apply]
Click this button to enter the input settings without closing the print option settings. This button is only displayed when 
the printer properties are accessed from the Printers folder. This button remains grayed out until a setting is changed.

10) [Help]
Click this button to browse the Help for the printer driver.
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Printing from an Application on Mac OS X 10.2.4 to Mac OS X 10.6.x

Once you have installed the PPD file as described in this manual, you can print directly from most of the Mac OS X 
applications.

Considerations and limitations
If you print a PDF file with the “Preview” application on Mac OS X 10.2.x, the page order will be incorrect. Use Adobe 
Reader.
The Cover Pages option of the Printer Features menu is available for Mac OS X 10.3.x or later.
The Cover Pages option of the Printer Features menu and the booklet printing cannot be used at the same time.
The Cover Pages option of the Printer Features menu and the N-up printing (multiple pages per sheet) cannot be used 
at the same time.
The Cover Pages option of the Printer Features menu and the Cover Page option for sending a print job with a banner 
page cannot be used at the same time.
To perform proof printing, private printing, hold printing, scheduled printing or e-Filing on Mac OS X 10.5, use LPR, 
AppleTalk or Bonjour.
To perform proof printing, private printing, hold printing, scheduled printing or e-Filing on Mac OS X 10.6.x, use LPR or 
Bonjour.
To use the user authentication function on Mac OS X 10.3.x to Mac OS X 10.4.x, perform the domain settings on 
[Applications] > [Utilities] > [Directory Access] > [Services] > [BSD Flat and NIS].
To use the user authentication function on Mac OS X 10.5.x, perform the domain settings on [Applications] > [Utilities] 
> [Directory Utilities] > [Services] > [BSD Flat and NIS].
To use the user authentication function on Mac OS X 10.6.x, perform the domain settings on [Accounts] > [Login 
Option] > [Network Account Server] > [Open the Directory Utility] > [Services] > [BSD Flat and NIS].
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How to print from Mac OS X 10.2.4 to Mac OS X 10.6.x
You do not need to switch printers before starting printing because they are all managed under the setting of [Print & Fax] 
of [System Preferences]. Once a printer is added to the Printer List, you can select any printer directly from the [Page 
Setup] dialog box or the [Print] dialog box.

Setting options and printing from Macintosh computers
In Mac OS X applications, print options are set from both the [Page Setup] dialog box and the [Print] dialog box.

The [Page Setup] dialog box varies depending on applications. In some applications, it is not included in the [File] 
menu, but in the [Print] dialog boxes.

Printing from Macintosh applications

1 Open a file and select [Page Setup] from the [File] menu of the application.

2 Select the name of the equipment at the [Format for] box and specify the Page Setup 
settings for your print job.

Setting the Page Setup varies depending on how you want to print a document.
 P.153 “Page Attributes”

3 Click [OK] to save the Page Setup settings.

4 Select [Print] from the [File] menu of the application.

5 In the dialog box that appears, make sure the name of the equipment is selected at the 
[Printer] box and specify the Print settings for your print job.

Setting the Print Setup varies depending on how you want to print a document.
 P.158 “Print dialog on Mac OS X 10.3.x to Mac OS X 10.6.x”
 P.179 “Print dialog on Mac OS X 10.2.x”

The [Print] dialog box varies depending on applications.
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6 Click [Print] to print a document.

The content set in the [Print] dialog box can be saved as [Presets]. Select [Save as] in the [Presets] box and 
save it under the desired name. If you use this preset content as the default setting, select it in the [Presets] 
box.
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Page Setup dialog on Mac OS X 10.2.4 to Mac OS X 10.6.x
The [Page Setup] dialog boxes can be displayed by selecting the [Page Setup] command from the [File] menu of the 
application.
In the [Page Setup] dialog boxes, you can specify the Page Attributes settings and manage the Custom Page Size 
settings.

The [Page Setup] dialog box varies depending on applications. In some applications, it is not included in the [File] 
menu, but in the [Print] dialog boxes.

Page Attributes

1) Format for
This option selects the printer to be used for printing.

2) Paper Size
This option selects the size of a document to be printed.

The default paper size is [US Letter] for the United States, and [A4] for the other countries.

3) Orientation
This option sets the paper printing direction.
- Portrait — The document is printed in the portrait direction.
- Landscape (90 degree) — The document is printed in the landscape direction from left.
- Landscape (270 degree) — The document is printed in the landscape direction from right. This is selectable only 

for Mac OS X 10.2.x to Mac OS X 10.4.x.

4) Scale
This option changes the size of the printed image on the page. Enter the zoom ratio to enlarge or reduce an image. 
You can set any integer from 1 to 10000 (%) for the zoom ratio. For Mac OS X 10.2.4 to Mac OS X 10.4.x, the 
acceptable range for the zoom ratio is from 25% to 400%.
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Custom Page Sizes (Only for e-STUDIO3510c Series)
The PPD file for e-STUDIO3510c Series supports the Custom Page Sizes.
The procedure to create the Custom Page Size varies between the Mac OS X 10.4.x to Mac OS X 10.6.x and Mac OS X 
10.2.8 to Mac OS X 10.3.x.

When you print on paper larger than standard sizes, print them one by one.

Creating Custom Page Size on Mac OS X 10.4.x to Mac OS X 10.6.x

1 Select [Manage Custom Sizes] in the [Paper Size] box.

The [Custom Page Sizes] dialog box appears. If Mac OS X 10.6.x is used, the [Custom Paper Size] dialog box 
appears.

2 Click [+].

A new custom page size name is added to the list.

If you want to create a new custom page size by duplicating an existing custom page size, select the custom 
page size name on the list and click [Duplicate].
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3 Double-click the added custom page size name on the list and rename the custom page 
size.

4 Enter the width and height in the [Page Size] boxes, and select the printer name of this 
equipment in the [Printer Margins] box.

If Mac OS X 10.6.x is used, enter the width and height in the [Paper Sizes] box, and then select your printer 
name in the [Non-Printable Area] box.
Use the margin settings that are automatically entered by selecting the printer name in the [Printer Margins] 
box.
You can delete the created custom page size by clicking [-].

5 Click [OK].
The Custom Page Size is saved and it can be selected in the [Paper Size] box in the Page Attributes menu.
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Creating Custom Page Size on Mac OS X 10.2.8 to Mac OS X 10.3.x

1 Select [Custom Paper Size] in the [Settings] box.

The Custom Paper Size menu is displayed.

2 Click [New].

A new custom page size name is added to the list.

If you want to create a new custom page size by duplicating an existing custom page size, select the custom 
page size name on the list and click [Duplicate].

3 Rename the custom page size.



9.PRINTING FROM MACINTOSH

Printing from an Application on Mac OS X 10.2.4 to Mac OS X 10.6.x    157

9 PRINTING FROM MACINTOSH

4 Enter the width and height in the [Page Size] boxes, and enter the printer margins in the 
[Printer Margins] boxes.

In the [Printer Margins] box, enter “0.17” inches.
You can delete the created custom page size by clicking [Delete].

5 Click [Save] and click [OK].

The Custom Page Size is saved and it can be selected in the [Paper Size] box in the Page Attributes menu.
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Print dialog on Mac OS X 10.3.x to Mac OS X 10.6.x
The [Print] dialog boxes can be displayed by selecting the [Print] command from the [File] menu of the application.

The [Print] dialog boxes are different between Mac OS X 10.2.x and Mac OS X 10.3.x to Mac OS X 10.6.x. See the 
following section for the descriptions of the [Print] dialog boxes for Mac OS X 10.2.x.

 P.179 “Print dialog on Mac OS X 10.2.x”

The [Page Setup] dialog boxes vary depending on applications. In some applications, it is not included in the [File] 
menu, but in the [Print] dialog box.

Copies & Pages
In the Copies & Pages menu, you can set general print options such as the number of copies, and sort printing.
The following screenshot is the Copies & Pages menu accessed from Microsoft Word.

1) Preview window
The print preview is displayed.

2) Show Quick Preview
Select this check box to enable the preview feature.

3) [Page Setup]
Click this button to display the [Page Setup] dialog box.

4) Copies
This option sets the number of printed copies.

5) Collated
Select this check box for sort-printing (1, 2, 3... 1, 2, 3...).

6) Pages
This option sets the range of pages to be printed.
- All — Select this option to print all pages.
- Current page — Select this option to print the page currently selected.
- Selection — Select this option to print only texts and objects selected on the page.
- From/to — Select this option to specify the pages to be printed. Enter the page range in the [From] and [to] boxes.
- Page range — Select this option to specify individual pages and/or page ranges to be printed. Enter page numbers 

and/or page ranges in the box.
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Layout
In the Layout menu, you can set N-up printing (multiple pages per sheet).

1) Pages per Sheet
This option sets the number of multiple pages printed on one sheet. The pages are reduced to fit the selected paper 
size automatically and are printed.
- 1 — Select this option if you do not wish to enable N-up printing.
- 2 — Select this option to print images from 2 pages arranged on one sheet.
- 4 — Select this option to print images from 4 pages arranged on one sheet.
- 6 — Select this option to print images from 6 pages arranged on one sheet.
- 9 — Select this option to print images from 9 pages arranged on one sheet.
- 16 — Select this option to print images from 16 pages arranged on one sheet.

2) Layout Direction
This option sets how pages are arranged on one sheet. This option is available only when N-up printing (printing 
multiple pages on one sheet) is enabled.

3) Border
Select this option if a border line is to be drawn on each page.
- None — Select this option if no border line is to be drawn.
- Single Hairline — Select this option to draw a single hairline for the border.
- Single Thin Line — Select this option to draw a single thin line for the border.
- Double Hairline — Select this option to draw a double hairline for the border.
- Double Thin Line — Select this option to draw a double thin line for the border.

4) Two-Sided
This option sets whether or not you want to print on both sides of the paper.
- Off — Select this option when you do not want to print on both sides of the paper.
- Long-edge binding — Select this option to bind along the long edge side of the paper. The direction to be printed 

on the back side of the paper differs depending on the orientation.

Across Left to Right Before Down — Pages arranged horizontally from left to right and then top to bottom 
on one sheet.

Across Right to Left Before Down — Pages arranged horizontally from right to left and then top to bottom 
on one sheet.

Down Before Across Left to Right — Pages arranged vertically from top to bottom and then left to right on 
one sheet.

Down Before Across Right to Left — Pages arranged vertically from top to bottom and then right to left on 
one sheet.
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- Short-edge binding — Select this option to bind along the short edge side of the paper. The direction to be printed 
on the back side of the paper differs depending on the orientation.

5) Reverse Page Orientation
This sets the orientation of paper exited. When the orientation of the paper is reversed with this setting, the top of the 
paper comes to the control panel side. This is selectable only for Mac OS X 10.5.x to Mac OS X 10.6.x.

6) Mirror
Select this check box to perform mirror printing of a page.
This check box is displayed only for the Mac OS X 10.6.x.

Output Options
In the Output Options menu, you can save a print job as a file.

This menu is displayed only for Mac OS X 10.3.x.

1) Save as File
Select this check box to save a print job as a file. When this box is selected, select the file type in the [Format] box.

2) Format
This option sets the format of a file to be saved.
- PDF — Select this option to save a print job as a PDF file.
- PostScript — Select this option to save a print job as a PS file.

Scheduler
In the Scheduler menu, you can set when a print job will be sent to the equipment.

1) Print Document
This option sets when a print job will be sent to the equipment.
- Now — Select this option to send a print job now.
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- At — Select this option to specify the time to send a print job. Set the time to send the print job. The print job will be 
held in the queue on Mac OS X until the specified time or until you resume the print job to be sent from the queue 
on Mac OS X.

- On Hold — Select this option to hold a print job in the queue on Mac OS X. When you select this, the print job will 
be held in the queue on Mac OS X until you resume the print job to be sent from the queue on Mac OS X.

2) Priority
Select the priority of a print job.

Paper Handling
In the Paper Handling menu, you can set Reverse page order printing and Odd or Even numbered page printing.
The screens in the Paper Handling menu vary between Mac OS X 10.3.x and Mac OS X 10.4.x.

Mac OS X 10.3.x

1) Reverse page order
Select this check box when you want to print a document beginning with the last page.

2) Print
Select whether all pages will be printed or only odd or even pages will be printed.

Mac OS X 10.4.x

1) Page Order
Select the page order for printing.

2) Print
Select whether to print all pages or only odd/even pages.

3) Destination Paper Size
Select the output paper size.
- Use documents paper size — Select this option to print on the same sized paper as the document size.
- Scale to fit paper size — Select this option to perform enlarge/reduce printing. Select the output paper size in the 

box. If you do not want to enlarge the document images when a larger paper size is selected, select the [Scale 
down only] check box.

1

2

1

3

2



9 PRINTING FROM MACINTOSH

162    Printing from an Application on Mac OS X 10.2.4 to Mac OS X 10.6.x

Mac OS X 10.5.x

1) Page To Print
Select whether all pages will be printed or only odd or even pages will be printed.

2) Destination Paper Size
Select the output paper size. The paper size selected in the [Page Setup] dialog box appears as the default setting.
- Scale to fit paper size — Select this check box to perform enlarge/reduce printing. When this is selected, select 

the output paper size in the box. If you do not want to enlarge the document images when a larger paper size is 
selected, select the [Scale down only] check box.

3) Page Order
Select the page order for printing.

Mac OS X 10.6.x

1) Page To Print
Select whether all pages will be printed or only odd or even pages will be printed.

2) Page Order
Select the page order for printing.

3) Destination Paper Size
Select the output paper size. The paper size selected in the [Page Setup] dialog box appears as the default setting.
- Scale to fit paper size — Select this check box to perform enlarge/reduce printing. When this is selected, select 

the output paper size in the box. If you do not want to enlarge the document images when a larger paper size is 
selected, select the [Scale down only] check box.
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ColorSync (Only for e-STUDIO3510c Series/e-STUDIO451c Series)

This menu is displayed only for Mac OS X 10.3.x to Mac OS X 10.4.x.

1) Color Conversion
Select the Color conversion.

2) Quartz Filter
Select the presence of the Quartz Filter.

Color Matching (Only for e-STUDIO3510c Series/e-STUDIO451c Series)

This menu is displayed only for Mac OS X 10.5.x to Mac OS X 10.6.x.

1) ColorSync
Select this if you want the application you are using to control the color management of the printouts.

2) In Printer
Select this if you want the printer you are using to control the color management of the printouts.

3) Profile
Select a color profile to be applied if you selected [ColorSync].
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Cover Page
In the Cover Page menu, you can set whether to send a print job with a banner page. The banner page includes 
information about job owner, job name, application name, date and time, and printer name.

1) Print Cover Page
You can set how to insert a banner page.
- None — Select this option to print without a banner page.
- Before document — Select this option to print a banner page before the document.
- After document — Select this option to print a banner page after the document.

2) Cover Page Type
Select the type of the cover page.

3) Billing Info
Enter the billing information to have it appear on the banner page.

Due to Mac OS limitations, text input into the [Billing Info] box will only be displayed up to the length of the field.

Error Handling
In the Error Handling menu, you can set how to report a PostScript error.

This menu is displayed only for Mac OS X 10.3.x to Mac OS X 10.4.x.

1) PostScript Errors
This sets whether to print a PostScript error report.
- No special reporting — Select this option if you do not want to print PostScript error information.
- Print detailed report — Select this option to print PostScript error information.
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2) Tray Switching
This option is not supported by this equipment.

Paper Feed
In the Paper Feed menu, you can set the paper source.

1) All pages from
Select this option when you want to use the same paper source for all pages. When this option is selected, select the 
paper source or paper type to be used in the box.

2) First page from
Select this option when you want to specify different paper sources for the first page and remaining pages. When this 
option is selected, select the paper source or paper type to be used for the first page in the box.

3) Remaining from
Select the paper source or paper type to be used for remaining pages in the box. This option can be selected only 
when you select the [First page from] option.

Print Mode
In the Print Mode menu, you can set the way this equipment handles the print job. This menu allows you to enable various 
job types, such as Private Print, Proof Print and Hold Print.

1) Print Mode
This option sets the type of print job.
- Normal — Select this option to print a job normally.
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- Proof — Select this option to print the first copy of a multicopy job and then wait for approval before printing the 
remaining copies. If a print job is sent as a proof job, one copy of the job is printed and the remaining copies are 
saved in the proof job queue on this equipment, which are not printed until you activate printing from the touch 
panel display. This option allows you to check a job’s output before printing the remaining copies and thereby 
reduce paper waste.
For the detailed instructions on how to use the touch panel display, see the following page:

 “Printing Guide” - “MANAGING PRINT JOBS FROM THE CONTROL PANEL” - “Proof Print jobs”
- Private — Select this option to print a private job. When this option is selected, specify the 5-digit password in the 

field next to the box. The print job is saved in the private job queue on this equipment, and not printed until you 
activate printing from the touch panel display of this equipment. This option is useful when you want to print a 
confidential document secured with a password. The user has to enter the password to print the private job when 
activating printing from the touch panel display.
For the detailed instructions on how to use the touch panel display, see the following page:

 “Printing Guide” - “MANAGING PRINT JOBS FROM THE CONTROL PANEL” - “Private Print jobs”

2) Department Code
The Department Code feature can be used for managing each job. For example, a system administrator can check 
how many sheets of copies a certain department has made.
Select whether a department code is required for printing. When this option is enabled, specify the 5-digit department 
code in the field next to the box.
Enabling the department code depends on whether this equipment is managed with department codes or not. Ask your 
administrator for your department code.

How the equipment performs printing for an invalid department code print job, for which an invalid department code 
is specified, varies depending on the Department Code Enforcement setting that can be set from TopAccess 
Administrator mode. When the Department Code Enforcement is set to “ON”, the invalid department code print job 
will be stored in the invalid department code print job list without being printed. When the Department Code 
Enforcement is set to “Print”, the invalid department code print job will be printed. When the Department Code 
Enforcement is set to “Delete”, the invalid department code print job will be deleted without being printed.

3) Do not Print Blank Pages
Select whether to ignore blank pages for printing.

When more than 2 is selected at the [Page per Sheet] option in the Layout menu, the blank pages will be 
printed.
Pages with header or footer will be printed even if the content is blank.

4) Distinguish Thin Lines
Select whether to print thin lines clearly.
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Printer Features
In the Printer Features menu, you can set special printing features.

Finishing
In the Finishing menu, you can set the destination, hole punching and stapling.

1) Destination
This option selects the destination tray.
- Printer’s Default — Select this to route the output to the default tray (that is set as the default tray for raw job in the 

Printer setting page of TopAccess Administrator's page).
- Exit Tray — Select this when no finisher is installed (e-STUDIO850 Series only).
- Inner Tray — Select this to route the output to the inner tray (Except e-STUDIO850 Series).
- Tray 1 — Select this to route the output to the upper tray of the Finisher.
- Tray 2 — Select this to route the output to the lower tray of the Finisher.
- Job Separator Upper — Select this to route the output to the upper tray of the Job Separator (e-STUDIO452 

Series / e-STUDIO453 Series / e-STUDIO282 Series / e-STUDIO283 Series only).
- Job Separator Lower — Select this to route the output to the lower tray of the Job Separator (e-STUDIO452 

Series / e-STUDIO453 Series / e-STUDIO282 Series / e-STUDIO283 Series only).

Depending on the type of finisher installed and destination settings, stapling and hole punching may not be 
performed.
Depending on the equipment settings, the paper may be delivered to a tray that cannot carry out stapling or 
hole punching when "Auto" is selected as the "Destination" option.
For e-STUDIO850 Series, "Exit Tray" is only available when no finisher is installed.
For e-STUDIO850 Series and e-STUDIO3510c Series, "Tray 1" and "Tray 2" can be selected when the 
Finisher, or Saddle Stitch Finisher are installed.
For e-STUDIO452 Series and e-STUDIO453 Series, "Tray 1" and "Tray 2" can be selected when the Hanging 
Finisher, Finisher (Type A), Finisher (Type B), or Saddle Stitch Finisher are installed.
For e-STUDIO452 Series, When the Finisher (Type B) is installed and stapling is enabled, select "Tray 2".
For e-STUDIO282 Series and e-STUDIO283 Series, "Tray 1" and "Tray 2" can be selected when the Hanging 
Finisher is installed, and "Tray 1" can be selected when the Saddle Stitch Finisher is installed.
For e-STUDIO282 Series and e-STUDIO283 Series, When the optional Job Separator is installed, you can 
select "Job Separator Upper" and "Job Separator Lower" instead of "Inner Tray".
For e-STUDIO451c Series, "Tray 1" and "Tray 2" can be selected when the Hanging Finisher, Finisher, or 
Saddle Stitch Finisher are installed.

2) Hole Punch
This option sets whether or not a print job is hole punched.
- Off — Select this option to print without hole punches.
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- Long Edge Punch without rotation — Select this option to create holes on the left side for a portrait document, or 
on the top for a landscape document.

- Short Edge Punch without rotation — Select this option to create holes on the top for a portrait document, or on 
the right for a landscape document.

- Long Edge Punch with 180 degree rotation — Select this option to create holes on the right side for a portrait 
document, or on the bottom for a landscape document.

- Short Edge Punch with 180 degree rotation — Select this option to create holes on the bottom for a portrait 
document, or on the left for a landscape document.

This option can be selected when the Hole Punch Unit (optional) is installed.
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3) Stapling
This option sets whether a print job is stapled.
- Off — Select this option to print without stapling.
- Upper Left (Portrait) / Upper Right (Landscape) — Select this option to staple on the upper left for a portrait 

document, or on the upper right for a landscape document.

- Middle Left (Portrait) / Middle Top (Landscape) — Select this option to double staple on the left for a portrait 
document, or on the top for a landscape document.

- Lower Left (Portrait) / Upper Left (Landscape) — Select this option to staple on the lower left for a portrait 
document, or on the upper left for a landscape document.

- Upper Right (Portrait) / Lower Right (Landscape) — Select this option to staple on the upper right for a portrait 
document, or on the lower right for a landscape document.

- Middle Right (Portrait) / Middle Bottom (Landscape) — Select this option to double staple on the right for a 
portrait document, or on the bottom for a landscape document.

- Lower Right (Portrait) / Lower Left (Landscape) — Select this option to staple on the lower right for a portrait 
document, or on the lower left for a landscape document.

- Middle Top (Portrait) / Middle Right (Landscape) — Select this option to double staple on the top for a portrait 
document, or on the right for a landscape document.
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- Middle Bottom (Portrait) / Middle Left (Landscape) — Select this option to double staple on the bottom for a 
portrait document, or on the left for a landscape document.

- Saddle Stitch (Portrait) / Saddle Stitch (Landscape) — Select this option to double staple in the center for a 
booklet to be printed. Select this only when booklet printing is performed.

This option can be selected when the optional Finisher is installed.
Only [Upper Left (Portrait)/Upper Right (Landscape)] can be selected when the Hanging Finisher (optional) is 
installed.
[Saddle Stitch (Portrait) / Saddle Stitch (Landscape)] can be selected only when the Saddle Stitch Finisher 
(optional) is installed.

Booklet
In the Booklet menu, you can set booklet printing.

1) Booklet Paper Size
Select a paper size for the booklet. Both sides of a sheet are printed with two pages. The booklet size will be half the 
size of the paper size that you specify.

2) Left to Right Page Layout
Select this check box to create a booklet that can be read from left to right.

3) Booklet Center Margin
Select the width of the margin added to the center.

4) Booklet Outer Margin
Select the width of the margin added to the short edge side of a sheet.
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Cover Pages
In the Cover Pages menu, you can set Front Cover printing and Back Cover printing.

1) Use Front Cover
This option sets front cover printing which allows you to insert or print a cover on a sheet fed from a different drawer or 
the bypass tray.
To enable cover printing, select this check box and select the location from where a cover sheet is to be fed and the 
print style to be used.

Source
Select from where the cover sheet is to be fed. When [Auto (Default)] is selected, the paper is automatically selected 
according to the printed document size.

The selectable values in the [Source] box vary depending on the optional devices installed on this equipment and 
their configuration in the Paper Feed menu.

Print Style
This option selects how to print the cover.
- Do not print on page — Select this option to insert a blank cover.
- Print on page — Select this option to print the first page image on the front side of a cover. When the Two-Sided 

Printing option is enabled in the Layout menu, the first two page images are printed on both sides of a cover.
- Print on 1 side of page — Select this option to print the first page image on the front side of a cover. This option is 

available only when the Two-Sided Printing option is enabled in the Layout menu.

2) Use Back Cover
This option sets back cover printing which allows you to insert or print a back cover on a sheet fed from a different 
drawer or the bypass tray.
To enable back cover printing, select this check box and select the location from where a back cover sheet is to be fed 
and the print style to be used.

Source
Select from where the cover sheet is to be fed. When [Auto (Default)] is selected, the paper is automatically selected 
according to the printed document size.

The selectable values in the [Source] box vary depending on the optional devices installed on this equipment and 
their configuration in the Paper Feed menu.

Print Style
This option selects how you want to print a back cover.
- Do not print on page — Select this option to insert a blank back cover.
- Print on page — Select this option to print the last page image on the front side of a back cover. When the Two-

Sided Printing option is enabled in the Layout menu, the last two page images are printed on both sides of a back 
cover.

- Print on 1 side of page — Select this option to print the last page image on the front side of a back cover. This 
option is available only when the Two-Sided Printing option is enabled in the Layout menu.

1
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Quality
In the Quality menu, you can specify various image quality features.

e-STUDIO282 Series / e-STUDIO283 Series / e-STUDIO452 Series / e-STUDIO453 Series /
e-STUDIO850 Series / e-STUDIO853 Series

1) Halftone
This option sets how to print halftones.
- Auto — Select this option to print using proper halftone depending on the contents in the document automatically.
- Detail — Select this option to print halftone in detail.
- Smooth — Select this option to print halftone smoothly.

2) Smoothing
Select this check box to print texts and graphics smoothly.

3) Toner Save
Select this check box to print in the Toner Save mode.

When the Toner Save mode is enabled, printing may become light.

e-STUDIO451c Series

1) Color Resolution Type
Select the combinations of color, resolution, and type.
- Mono Low-res Auto — Select this to print in black and white with low resolution and automatic image quality type.
- Mono Low-res Detail — Select this to print in black and white with low resolution and detailed image quality type.
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- Mono Low-res Smooth — Select this to print in black and white with low resolution and smoothing image quality 
type.

- Color Low-res General — Select this to print in color with low resolution and general image quality type.
- Color Low-res Photo — Select this to print in color with low resolution and photo image quality type.
- Color Low-res Presentation — Select this to print in color with low resolution and presentation image quality type.
- Color Low-res LineArt — Select this to print in color with low resolution and line art image quality type.
- Color High-res General — Select this to print in color with high resolution and general image quality type.
- Color High-res Photo — Select this to print in color with high resolution and photo image quality type.
- Color High-res Presentation — Select this to print in color with high resolution and presentation image quality 

type.
- Color High-res LineArt — Select this to print in color with high resolution and line art image quality type.
- Color Low-res Transparency — Select this to print in color with low resolution on the transparency sheet.
- Color High-res Transparency — Select this to print in color with high resolution on the transparency sheet.

When the optional expansion memory is not installed, the job will not be printed if you select “Color High-res 
General”, “Color High-res Photo”, Color High-res Presentation”, “Color High-res LineArt”, or “Color High-res 
Transparency”.

2) Pure Black and Gray
Select whether printing the document in gray scale.
- Off — Select this to print the document in color mode.
- Pure Black only — Select this to print the contents in black where the percentage of all colors (cyan, magenta, 

and yellow) is 100%.
- Pure Black and Pure Gray — Select this to print the contents in black where the percentage of all color —cyan, 

magenta, and yellow— is 100% (C=100% -> K=100%, M=100% -> K=100%, Y=100% -> K=100%), and print the 
contents in gray scale where the percentage of each color —cyan, magenta, and yellow— is the same percentage 
(C=M=Y=n% -> K=n%).

3) Black Over Print
Select this when printing background content that has black text overlayed on it. If this is not enabled, the background 
of the black content will not print. When you print a document that has any of its content on background with black text 
overlayed, enable this option.

4) Smoothing
Select whether printing the texts and graphics smoothly.

5) Toner Save
Select this to print in the toner save mode.
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Color Settings (Only for e-STUDIO3510c Series)
In the Color Settings 1 and Color Settings 2 menu, you can adjust the color settings for printing.

1) Color Type
This sets whether a print job is printed in color mode or monochrome mode.
- Auto — Select this to determine the color mode automatically. When a print job is a black and white document, the 

system automatically prints the document in monochrome mode. When a print job is a color document, it prints the 
document in color mode.

- Color — Select this to print a document in color mode.
- Mono — Select this to print a document in monochrome mode.
- Black and Red — Select this to print a document in twin color mode with red. When this is selected, the black parts 

of the document are printed in black and color parts of the document are printed in red.
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- Black and Green — Select this to print a document in twin color mode with green. When this is selected, the black 
parts of the document are printed in black and color parts of the document are printed in green.

- Black and Blue — Select this to print a document in twin color mode with blue. When this is selected, the black 
parts of the document are printed in black and color parts of the document are printed in blue.

- Black and Cyan — Select this to print a document in twin color mode with cyan. When this is selected, the black 
parts of the document are printed in black and color parts of the document are printed in cyan.

- Black and Magenta — Select this to print a document in twin color mode with magenta. When this is selected, the 
black parts of the document are printed in black and color parts of the document are printed in magenta.

- Black and Yellow — Select this to print a document in twin color mode with yellow. When this is selected, the 
black parts of the document are printed in black and color parts of the document are printed in yellow.

- Black and White — Select this to print a document in twin color mode with white. When this is selected, the black 
parts of the document are printed in black and color parts of the document are not printed.

2) Halftone
This sets how halftones are printed.
- Auto — Select this to print using proper halftone depending on the contents in the document automatically.
- Detail — Select this to print halftone in detail.
- Smooth — Select this to print halftone smoothly.

3) Distinguish Thin Lines
Check this to print thin lines clearly.

4) Toner Save
Select this check box to print in the Toner Save mode.

When the Toner Save mode is enabled, printing may become light.

5) Image Type
This sets how colors are printed by selecting the job type. The printer driver automatically applies proper image quality 
for selected job type.
- General — Select this to apply proper image quality for printing a general color document.
- Photograph — Select this to apply proper image quality for printing photos.
- Presentation — Select this to apply proper image quality for printing a vivid document.
- Line Art — Select this to apply proper image quality for printing a document contains a lot of characters or line arts.

Other than “General” cannot be selected when “Mono” is selected at the “Color Type” drop down menu.

6) Black Over Print
Check this when printing background content that has black text overlayed on it. If this is not enabled, the background 
of the black content will not print. When you print a document that has any of its content on background with black text 
overlayed, enable this option.

7) Pure Black and Gray
Select whether printing the black and gray scale contents in a document using the black toner.
- Off — Select this to print the document in color mode.
- Black - Auto — Select this to print black contents using the black toner according to the document.
- Black - Text — Select this to print the black texts using the black toner.
- Black - Text and Graphic — Select this to print the black texts and graphics using the black toner.
- Black - Text, Graphic and Image  — Select this to print the black texts, graphics and images using the black toner.
- Black and Gray - Auto — Select this to print black and gray scale contents using the black toner according to the 

document.
- Black and Gray - Text — Select this to print the black and gray scale texts using the black toner.
- Black and Gray - Text and Graphic — Select this to print the black and gray scale texts and graphics using the 

black toner.
- Black and Gray - Text, Graphic and Image — Select this to print the black and gray scale texts, graphics, and 

images using the black toner.

8) Color Balance
Adjust the density of each color for printing. You can set from -4 to 4 in units of 1.

9) Image Attribute
This sets the sharpness, brightness, contrast, and saturation for printing.
- Sharpness

Adjust the sharpness for printing. You can set from -4 (smoothest) to 4 (sharpest) in units of 1 by moving the scroll 
bar.
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- Brightness
Adjust the brightness for printing. You can set from -4 (darkest) to 4 (lightest) in units of 1 by moving the scroll bar.

- Contrast
Adjust the contrast for printing. You can set from -4 (lowest) to 4 (highest) in units of 1 by moving the scroll bar.

- Saturation
Adjust the saturation for printing. You can set from -4 (low clear) to 4 (high clear) in units of 1 by moving the scroll 
bar.

e-Filing
In the e-Filing menu, you can send and store print jobs from your application to e-Filing on this equipment (hard disk). The 
jobs stored to e-Filing can then be printed using the touch panel. You can select either a public or user box in which to 
store print jobs. You can also specify a folder in which the print jobs are to be stored in these boxes. The public box is 
shared by all users who can view the jobs stored in this box. User boxes are ones that users can create as desired. 
Access to user boxes can be restricted with a password.

The e-Filing menu is displayed when the Plug-in file is installed in Mac OS X 10.4.x to Mac OS X 10.6.x.

1) Store this document to e-Filing
To store a print job in e-Filing, select this check box.

2) Print the document
If you want to print the job as well as saving it to a box, select this check box.

3) Destination
Select either the public box or a user box in which to store print jobs.

5-digit password
If a password is set in the user box, enter the 5-digit password.

Destination folder
When you specify a folder in which the print job is to be stored in a public or a user box, enter the folder name.

If the entered folder name is not found, a new folder is created under this name.
Enter the folder name within 64 characters.
Once there are 100 folders, you cannot create any more.
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Watermark
In the watermark menu, you can overprint the document with useful information, such as [Confidential], [Draft], [Proof] and 
[Top Secret]. You can choose from several predefined watermarks or you can create and save your own custom 
watermarks. Watermarks consist of text only.

The watermark menu is displayed when the Plug-in file is installed in Mac OS X 10.4.x to Mac OS X 10.6.x.

1) Text
Select the watermark. You can create a new watermark if there is none you want to apply on the box.

You can enter up to 63 alphanumeric characters. If too many characters are entered, the watermark may not be printed 
correctly.

2) Font
Select the font to be used for the watermark text.

3) Size
Enter the font size for the watermark text.
The font size can be set from 6 to 300 pt in units of 1 pt. You can also set the font size by moving the scroll bar.

4) Angle
Enter the degree of the angle for rotating the watermark text. The angle can be set from 0 to 360 degrees in units of 1 
degree. You can also set the degree of the angle by moving the scroll bar.

5) Color
Select the color of the watermark text. The documents are printed with a shading of gray instead of the selected color.

6) Print over the document
Select this to print the watermark text placed above everything.

7) Print under the document
Select this to print the watermark text placed below everything.

8) Position
Adjust the position of the watermark by moving the scroll bars.

1

2

5

7

83

4

6



9 PRINTING FROM MACINTOSH

178    Printing from an Application on Mac OS X 10.2.4 to Mac OS X 10.6.x

Supply Levels
In the Supply Levels menu, the remaining toner and paper can be checked.
 This menu is displayed when Mac OS X 10.4 to 10.6.x is used.

Summary
In the Summary menu, you can confirm the current settings for printing.
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Print dialog on Mac OS X 10.2.x
The [Print] dialog boxes can be displayed by selecting the [Print] command from the [File] menu of the application.

The [Print] dialog boxes are different between Mac OS X 10.2.x and Mac OS X 10.3.x to Mac OS X 10.6.x. See the 
following section for the descriptions of the [Print] dialog box for Mac OS X 10.3.x to Mac OS X 10.6.x.

 P.158 “Print dialog on Mac OS X 10.3.x to Mac OS X 10.6.x”

The [Print] dialog box varies depending on applications.

Copies & Pages
In the Copies & Pages menu, you can set the general print options such as number of copies and sort printing.

1) Copies
This option sets the number of printed copies.

2) Collated
Select this check box for sort-printing (1, 2, 3... 1, 2, 3...).

3) Pages
This option sets the pages to be printed.
- All — Select this option to print all pages.
- From/to — Select this option to specify the pages to be printed. Enter the page range in the [From] and [to] boxes.

1 2
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Layout
In the Layout menu, you can set N-up printing (multiple pages per sheets). The items in the Layout menu vary depending 
on the Mac OS X version.

1) Pages per Sheet
This option sets the number of multiple pages to be printed on one sheet. The pages are reduced to fit the selected 
paper size automatically and are printed.
- 1 — Select this option if you do not wish to perform N-up printing.
- 2 — Select this option to print images from 2 pages arranged on one sheet.
- 4 — Select this option to print images from 4 pages arranged on one sheet.
- 6 — Select this option to print images from 6 pages arranged on one sheet.
- 9 — Select this option to print images from 9 pages arranged on one sheet.
- 16 — Select this option to print images from 16 pages arranged on one sheet.

2) Layout Direction
This option sets how pages are arranged on one sheet. This option is available only when N-up printing (printing 
multiple sheets on a page) is enabled.

3) Border
Select if a border line is to be drawn on each page.
- None — Select this option if no border line is to be drawn.
- Single hairline — Select this option to draw a single hairline for the border.
- Single thin line — Select this option to draw a single thin line for the border.
- Double hairline — Select this option to draw a double hairline for the border.
- Double thin line — Select this option to draw a double thin line for the border.

Across Left to Right Before Down — Pages arranged horizontally from left to right and then top to bottom 
on one sheet.

Across Right to Left Before Down — Pages arranged horizontally from right to left and then top to bottom 
on one sheet.

Down Before Across Left to Right — Pages arranged vertically from top to bottom and then left to right on 
one sheet.

Down Before Across Right to Left — Pages arranged vertically from top to bottom and then right to left on 
one sheet.

1

2

3



9.PRINTING FROM MACINTOSH

Printing from an Application on Mac OS X 10.2.4 to Mac OS X 10.6.x    181

9 PRINTING FROM MACINTOSH

Duplex
In the Duplex menu, you can set Two-Sided printing (printing on both sides of a sheet).

1) Print on Both Sides
Select this check box to print on both sides of the paper. When this box is selected, select the binding direction at the 
[Binding] option.

2) Binding
This option sets the type of binding for Two-sided printed pages.
- Long-edge Binding — Select this option to bind along the long edge side of paper. The direction to be printed on 

the back side of the paper differs depending on the orientation.

- Short-edge Binding — Select this option to bind along the short edge side of paper. The direction to be printed on 
the back side of the paper differs depending on the orientation.

Output Options
In the Output Options menu, you can save a print job as a file.

1) Save as File
Select this check box to save a print job as a file. When this box is selected, select the file type in the [Format] box.

2) Format
This option sets the format to save a file.
- PDF — Select this option to save a print job as a PDF file.
- PostScript — Select this option to save a print job as a PS file.
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Error Handling
In the Error Handling menu, you can set how to report a PostScript error.

1) PostScript Errors
This option sets whether to print a PostScript error report.
- No special reporting — Select this option if you do not want to print PostScript error information.
- Print detailed report — Select this option to print PostScript error information.

2) Tray Switching
This option is not supported by this equipment.

Paper Feed
In the Paper Feed menu, you can select the paper source or media type.

1) All pages from
Select this option when you want to use the same paper source for all pages. When this option is selected, select the 
paper source or paper type to be used in the box.

2) First page from
Select this option when you want to specify different paper source for the first page and remaining pages. When this 
option is selected, select the paper source or paper type to be used for the first page in the box.

3) Remaining from
Select the paper source or paper type to be used for the remaining pages in the box. This option can be selected only 
when you select the [First page from] option.
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Printer Features
In the Printer Features menu, you can set special printing features.

 P.183 “Booklet”
 P.184 “Quality”
 P.185 “Color Settings 1 (Only for e-STUDIO3510c Series)”
 P.186 “Color Settings 2 (Only for e-STUDIO3510c Series)”
 P.187 “Color Settings 3 (Only for e-STUDIO3510c Series)”
 P.187 “Color Settings 4 (Only for e-STUDIO3510c Series)”
 P.188 “Finishing”
 P.191 “Printing Modes”
 P.192 “Printing Modes DC”
 P.193 “Private Document Password”

Do not use the Cover Pages menu.

Booklet
In the Booklet menu, you can set booklet printing.

1) Booklet Paper Size
Select a paper size for the booklet. Both sides of a sheet are printed with two pages. The booklet size will be half the 
size of the paper size that you specify.

2) Left to Right Page Layout
Select this check box to create a booklet that can be read from left to right.

3) Booklet Center Margin
Select the width of space added to the center.

4) Booklet Outer Margin
Select the width of space added to the short edge side of a sheet.
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Quality
In the Quality menu, you can specify various image quality features.

e-STUDIO282 Series / e-STUDIO283 Series / e-STUDIO452 Series / e-STUDIO453 Series /
e-STUDIO850 Series / e-STUDIO853 Series

1) Halftone
This option sets how to print halftones.
- Auto — Select this option to print using proper halftone depending on the contents in the document automatically.
- Detail — Select this option to print halftone in detail.
- Smooth — Select this option to print halftone smoothly.

2) Smoothing
Select this check box to print texts and graphics smoothly.

3) Toner Save
Select this check box to print in the Toner Save mode.

When the Toner Save mode is enabled, printing may become light.

e-STUDIO451c Series

1) Color Resolution Type
Select the combinations of color, resolution, and type.
- Mono Low-res Auto — Select this to print in black and white with low resolution and automatic image quality type.
- Mono Low-res Detail — Select this to print in black and white with low resolution and detailed image quality type.
- Mono Low-res Smooth — Select this to print in black and white with low resolution and smoothing image quality 

type.
- Color Low-res General — Select this to print in color with low resolution and general image quality type.
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- Color Low-res Photo — Select this to print in color with low resolution and photo image quality type.
- Color Low-res Presentation — Select this to print in color with low resolution and presentation image quality type.
- Color Low-res LineArt — Select this to print in color with low resolution and line art image quality type.
- Color High-res General — Select this to print in color with high resolution and general image quality type.
- Color High-res Photo — Select this to print in color with high resolution and photo image quality type.
- Color High-res Presentation — Select this to print in color with high resolution and presentation image quality 

type.
- Color High-res LineArt — Select this to print in color with high resolution and line art image quality type.
- Color Low-res Transparency — Select this to print in color with low resolution on the transparency sheet.
- Color High-res Transparency — Select this to print in color with high resolution on the transparency sheet.

When the optional expansion memory is not installed, the job will not be printed if you select “Color High-res 
General”, “Color High-res Photo”, Color High-res Presentation”, “Color High-res LineArt”, or “Color High-res 
Transparency”.

2) Pure Black and Gray
Select whether printing the document in gray scale.
- Off — Select this to print the document in color mode.
- Pure Black only — Select this to print the contents in black where the percentage of all colors (cyan, magenta, 

and yellow) is 100%.
- Pure Black and Pure Gray — Select this to print the contents in black where the percentage of all color —cyan, 

magenta, and yellow— is 100% (C=100% -> K=100%, M=100% -> K=100%, Y=100% -> K=100%), and print the 
contents in gray scale where the percentage of each color —cyan, magenta, and yellow— is the same percentage 
(C=M=Y=n% -> K=n%).

3) Black Over Print
Select this when printing background content that has black text overlayed on it. If this is not enabled, the background 
of the black content will not print. When you print a document that has any of its content on background with black text 
overlayed, enable this option.

4) Smoothing
Select whether printing the texts and graphics smoothly.

5) Toner Save
Select this to print in the toner save mode.

Color Settings 1 (Only for e-STUDIO3510c Series)
In the Color Settings 1, you can set special features for printing.

1) Color Type
This sets whether a print job is printed in color mode or monochrome mode.
- Auto — Select this to determine the color mode automatically. When a print job is a black and white document, the 

system automatically prints the document in monochrome mode. When a print job is a color document, it prints the 
document in color mode.

- Color — Select this to print a document in color mode.
- Mono — Select this to print a document in monochrome mode.
- Black and Red — Select this to print a document in twin color mode with red. When this is selected, the black parts 

of the document are printed in black and color parts of the document are printed in red.
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- Black and Green — Select this to print a document in twin color mode with green. When this is selected, the black 
parts of the document are printed in black and color parts of the document are printed in green.

- Black and Blue — Select this to print a document in twin color mode with blue. When this is selected, the black 
parts of the document are printed in black and color parts of the document are printed in blue.

- Black and Cyan — Select this to print a document in twin color mode with cyan. When this is selected, the black 
parts of the document are printed in black and color parts of the document are printed in cyan.

- Black and Magenta — Select this to print a document in twin color mode with magenta. When this is selected, the 
black parts of the document are printed in black and color parts of the document are printed in magenta.

- Black and Yellow — Select this to print a document in twin color mode with yellow. When this is selected, the 
black parts of the document are printed in black and color parts of the document are printed in yellow.

- Black and White — Select this to print a document in twin color mode with white. When this is selected, the black 
parts of the document are printed in black and color parts of the document are not printed.

2) Halftone
This sets how halftones are printed.
- Auto — Select this to print using proper halftone depending on the contents in the document automatically.
- Detail — Select this to print halftone in detail.
- Smooth — Select this to print halftone smoothly.

3) Distinguish Thin Lines
Check this to print thin lines clearly.

Color Settings 2 (Only for e-STUDIO3510c Series)
In the Color Settings 2, you can set image quality for printing.

1) Image Type
This sets how colors are printed by selecting the job type. The printer driver automatically applies proper image quality 
for selected job type.
- General — Select this to apply proper image quality for printing a general color document.
- Photograph — Select this to apply proper image quality for printing photos.
- Presentation — Select this to apply proper image quality for printing a vivid document.
- Line Art — Select this to apply proper image quality for printing a document contains a lot of characters or line arts.

Other than “General” cannot be selected when “Mono” is selected at the “Color Type” drop down menu.

2) Black Over Print
Check this when printing background content that has black text overlayed on it. If this is not enabled, the background 
of the black content will not print. When you print a document that has any of its content on background with black text 
overlayed, enable this option.

3) Pure Black and Gray
Select whether printing the black and gray scale contents in a document using the black toner.
- Off — Select this to print the document in color mode.
- Black - Auto — Select this to print black contents using the black toner according to the document.
- Black - Text — Select this to print the black texts using the black toner.
- Black - Text and Graphic — Select this to print the black texts and graphics using the black toner.
- Black - Text, Graphic and Image  — Select this to print the black texts, graphics and images using the black toner.
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- Black and Gray - Auto — Select this to print black and gray scale contents using the black toner according to the 
document.

- Black and Gray - Text — Select this to print the black and gray scale texts using the black toner.
- Black and Gray - Text and Graphic — Select this to print the black and gray scale texts and graphics using the 

black toner.
- Black and Gray - Text, Graphic and Image — Select this to print the black and gray scale texts, graphics, and 

images using the black toner.

Color Settings 3 (Only for e-STUDIO3510c Series)
In the Color Settings 3, you can set color balance for printing.

1) Color Balance - Cyan
Adjust the density of cyan for printing. You can set from -4 to 4 in units of 1.

2) Color Balance - Magenta
Adjust the density of magenta for printing. You can set from -4 to 4 in units of 1.

3) Color Balance - Yellow
Adjust the density of yellow for printing. You can set from -4 to 4 in units of 1.

4) Color Balance - Black
Adjust the density of black for printing. You can set from -4 to 4 in units of 1.

Color Settings 4 (Only for e-STUDIO3510c Series)
In the Color Settings 4, you can set image attributes for printing.

1) Contrast
Adjust the contrast for printing. You can set from -4 (lowest) to 4 (highest) in units of 1 by moving the scroll bar.

2) Sharpness
Adjust the sharpness for printing. You can set from -4 (smoothest) to 4 (sharpest) in units of 1 by moving the scroll bar.
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3) Brightness
Adjust the brightness for printing. You can set from -4 (darkest) to 4 (lightest) in units of 1 by moving the scroll bar.

4) Saturation
Adjust the saturation for printing. You can set from -4 (low clear) to 4 (high clear) in units of 1 by moving the scroll bar.

Finishing
In the Finishing menu, you can set the destination, hole punching and stapling.

1) Destination
This option selects the destination tray.
- Printer’s Default — Select this to route the output to the default tray (that is set as the default tray for raw job in the 

Printer setting page of TopAccess Administrator's page).
- Exit Tray — Select this when no finisher is installed (e-STUDIO850 Series only).
- Inner Tray — Select this to route the output to the inner tray (Except e-STUDIO850 Series).
- Tray 1 — Select this to route the output to the upper tray of the Finisher.
- Tray 2 — Select this to route the output to the lower tray of the Finisher.
- Job Separator Upper — Select this to route the output to the upper tray of the Job Separator (e-STUDIO452 

Series / e-STUDIO453 Series / e-STUDIO282 Series / e-STUDIO283 Series only).
- Job Separator Lower — Select this to route the output to the lower tray of the Job Separator (e-STUDIO452 

Series / e-STUDIO453 Series / e-STUDIO282 Series / e-STUDIO283 Series only).

Depending on the type of finisher installed and destination settings, stapling and hole punching may not be 
performed.
Depending on the equipment settings, the paper may be delivered to a tray that cannot carry out stapling or 
hole punching when "Auto" is selected as the "Destination" option.
For e-STUDIO850 Series, "Exit Tray" is only available when no finisher is installed.
For e-STUDIO850 Series and e-STUDIO3510c Series, "Tray 1" and "Tray 2" can be selected when the 
Finisher, or Saddle Stitch Finisher are installed.
For e-STUDIO452 Series and e-STUDIO453 Series, "Tray 1" and "Tray 2" can be selected when the Hanging 
Finisher, Finisher (Type A), Finisher (Type B), or Saddle Stitch Finisher are installed.
For e-STUDIO452 Series, When the Finisher (Type B) is installed and stapling is enabled, select "Tray 2".
For e-STUDIO282 Series and e-STUDIO283 Series, "Tray 1" and "Tray 2" can be selected when the Hanging 
Finisher is installed, and "Tray 1" can be selected when the Saddle Stitch Finisher is installed.
For e-STUDIO282 Series and e-STUDIO283 Series, When the optional Job Separator is installed, you can 
select "Job Separator Upper" and "Job Separator Lower" instead of "Inner Tray".
For e-STUDIO451c Series, "Tray 1" and "Tray 2" can be selected when the Hanging Finisher, Finisher, or 
Saddle Stitch Finisher are installed.
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2) Hole Punch
This option sets whether or not a print job is hole punched.
- Off — Select this option to print without hole punches.
- Long Edge Punch without rotation — Select this option to create holes on the left side for a portrait document, or 

on the top for a landscape document.

- Short Edge Punch without rotation — Select this option to create holes on the top for a portrait document, or on 
the right for a landscape document.

- Long Edge Punch with 180 degree rotation — Select this option to create holes on the right side for a portrait 
document, or on the bottom for a landscape document.

- Short Edge Punch with 180 degree rotation — Select this option to create holes on the bottom for a portrait 
document, or on the left for a landscape document.

This option can be selected when the Hole Punch Unit (optional) is installed.

3) Stapling
This option sets whether a print job is stapled.
- Off — Select this option to print without stapling.
- Upper Left (Portrait) / Upper Right (Landscape) — Select this option to staple on the upper left for a portrait 

document, or on the upper right for a landscape document.

- Middle Left (Portrait) / Middle Top (Landscape) — Select this option to double staple on the left for a portrait 
document, or on the top for a landscape document.
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- Lower Left (Portrait) / Upper Left (Landscape) — Select this option to staple on the lower left for a portrait 
document, or on the upper left for a landscape document.

- Upper Right (Portrait) / Lower Right (Landscape) — Select this option to staple on the upper right for a portrait 
document, or on the lower right for a landscape document.

- Middle Right (Portrait) / Middle Bottom (Landscape) — Select this option to double staple on the right for a 
portrait document, or on the bottom for a landscape document.

- Lower Right (Portrait) / Lower Left (Landscape) — Select this option to double staple on the lower right for a 
portrait document, or on the lower left for a landscape document.

- Middle Top (Portrait) / Middle Right (Landscape) — Select this option to double staple on the top for a portrait 
document, or on the right for a landscape document.

- Middle Bottom (Portrait) / Middle Left (Landscape) — Select this option to double staple on the bottom for a 
portrait document, or on the left for a landscape document.

- Saddle Stitch (Portrait) / Saddle Stitch (Landscape) — Select this option to double staple in the center for a 
booklet to be printed. Select this only when booklet printing is performed.
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This option can be selected when the optional Finisher is installed.
Only [Upper Left (Portrait)/Upper Right (Landscape)] can be selected when the Hanging Finisher (optional) is 
installed.
[Saddle Stitch (Portrait) / Saddle Stitch (Landscape)] can be selected only when the Saddle Stitch Finisher 
(optional) is installed.

Printing Modes
In the Printing Modes menu, you can set the way this equipment handles the print job. This menu allows you to enable 
various job types, such as Private Print, Proof Print and Hold Print.

1) Print Mode
This option sets the type of print job.
- Normal — Select this option to print a job normally.
- Hold — Select this option to print a hold job. The print job, sent as a hold job, is saved in the hold job queue on this 

equipment. To perform printing, select the desired job on the touch panel display and press [PRINT]. This option is 
useful to prevent you from forgetting to remove printed sheets.
For the detailed instructions on how to use the touch panel display, see the following page:

 “Printing Guide” - “MANAGING PRINT JOBS FROM THE CONTROL PANEL” -  “Hold Print jobs”
- Proof — Select this option to print the first copy of a multicopy job and then wait for approval before printing the 

remaining copies. If a print job is sent as a proof job, one copy of the job is printed and the remaining copies are 
saved in the proof job queue on this equipment, which are not printed until you activate printing from the touch 
panel display. This option allows you to check a job’s output before printing the remaining copies and thereby 
reduce paper waste.
For the detailed instructions on how to use the touch panel display, see the following page:

 “Printing Guide” - “MANAGING PRINT JOBS FROM THE CONTROL PANEL” - “Proof Print jobs”
- Private - Password — Select this option to print a private job. When this is selected, specify the 5-digit password 

in the Private Document Password menu. The print job is saved in the private job queue on this equipment, and not 
printed until you activate printing from the touch panel display of this equipment. This option is useful when you 
want to print a confidential document secured with a password. The user has to enter the password to print the 
private job when activating printing from the touch panel display.
For details on the Private Document Password menu, see the following page:

 P.193 “Private Document Password”
For the detailed instructions on how to use the touch panel display, see the following page:

 “Printing Guide” - “MANAGING PRINT JOBS FROM THE CONTROL PANEL” - “Private Print jobs”

2) Department Code
The Department Code feature can be used for managing each job. For example, a system administrator can check 
how many sheets of copies a certain department has made.
Select this check box if a department code is required for printing. When this option is enabled, specify the 5-digit 
department code in the DC menu.
Enabling the department code depends on whether this equipment is managed with department codes or not. Ask your 
administrator for your department code.

 P.192 “Printing Modes DC”

3) Distinguish Thin Lines
Select this check box to print thin lines clearly.
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4) Do not Print Blank Pages
Select this check box to ignore blank pages for printing.

When more than 2 is selected at the [Page per Sheet] option in the Layout menu, the blank pages will be 
printed.
Pages with header or footer will be printed even if the content is blank.

Printing Modes DC
In the Printing Modes DC menu, you can specify your department code, if the Department Code option is enabled on the 
equipment. Before specifying the department code, you must check the Department Code option in the Printing Modes 
menu. Then specify the department code in this menu.

How the equipment performs printing for an invalid department code print job, for which an invalid department code is 
specified, varies depending on the Department Code Enforcement setting that can be set from TopAccess 
Administrator mode. When the Department Code Enforcement is set to “ON”, the invalid department code print job will 
be stored in the invalid department code print job list without being printed. When the Department Code Enforcement 
is set to “Print”, the invalid department code print job will be printed. When the Department Code Enforcement is set to 
“Delete”, the invalid department code print job will be deleted without being printed.

1) Department Code (DC) - Digit 1
Select the first digit of the department code.

2) Department Code (DC) - Digit 2
Select the second digit of the department code.

3) Department Code (DC) - Digit 3
Select the third digit of the department code.

4) Department Code (DC) - Digit 4
Select the fourth digit of the department code.

5) Department Code (DC) - Digit 5
Select the fifth digit of the department code.
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Private Document Password
In the Private Document Password menu, you can specify the Document ID number for the private job. It is recommended 
to specify the Private Document Password when you select to print a private job. If you do not specify the Private 
Document Password, the private job uses the default Private Document Password “00000”.

1) Password - Digit 1
Select the first digit of the Document ID.

2) Password - Digit 2
Select the second digit of the Document ID.

3) Password - Digit 3
Select the third digit of the Document ID.

4) Password - Digit 4
Select the fourth digit of the Document ID.

5) Password - Digit 5
Select the fifth digit of the Document ID.

Summary
In the Summary menu, you can confirm the current settings for printing.
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